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(5 el malindl JRE e

Anal Agill dlee 68510235 0 O Al Cua 2 1)

g 5 by eI 39S, lrdicuall By

ESP8266 = DHT 11 _adiwa Juagl

s e

(s soall yrite iy i) Ay sk ) eives (DHT 11 :S) yridiiesadll ¢ 58
GPIO (sl pli i 5 sl e s

Aiai¥) Slllaia g peliuall 3ea
'ESP32 5l ESp8266 s skl san 55 DHT11 535 5 (e Adlsall 500301 Juasl @
askaill 3as ) (<5 3.3) Ve 2e: DHT11 535l Vee sl ©
Saad) Gl Lasils ESP8266
skl a3 51 (im0l DHTAY saa 50 (< 0) G i b doasl
3591 Gl Hadiul, ESP8266

alaiiuly ESP8266 _uskill 32 8 D1 (GPIO5) = DHT11 5as 5 iy Jucaf

P REIN
3 DHT11 dashall g 3 ) Al da 2 jmdies 1Jla) smdiiesal) clily 35 jal 368 i)
(DHT 22

4 0aldl) GPIO (o5 Ui ye efiindll Sie il o

import dht

sensor = dht. DHT11(machine.Pin(5)) #orDHT22
(i 551 al) dn ya5 A skl jaiiias s DHT usial)
diinnal) 43S0 e A0 A8yl Aoy el ULy 13 e R e e S
DHT11 1 o S
sensor.measure(
temperature = sensor.temperature()
humidity = sensor.humidity(
raditusal) iy e () S A aladiuly REPL (8 Jsdiiall Glily (i e ) o
JBa 7 s
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("Temperature:", temperature, "°C") <
("Humidity:", humid, "%") <)
(Al ¥ Adla) 5 patisall 36 Al Adls 8 o @
:while True 4&la Jals (i pall gsel il s S ua @
:while True
sensor.measure()
temperature = sensor.temperature()
humidity = sensor.humidity()
("Temperature:", temperature, "°C") o5s'|
("Humidity:", humidiity, "%") —cis/
time. sleep(5)
eA;.u.n.M_u.m]\ \J@ &l \_)sl\um_)\_)m).]ha}u\w\cué\ CL\A.? 4.;.:..4.1
Adlall eUayy 43Ul 56 3l JB o) 55 ksl # time.sleep(5)
REPL (& 8 aiusall 481 sal) (Ra) 138
(F5) dsids e il 5 (oma ) Gl Jinl
u.mla_ml\ 3) ‘c,Un;\ g_uh M\A‘; [ )
Augill 3 jand g u_n)um}d\ sadll o
4a gl Q\M\:\_}ﬁ.«w&) RO uads;_dl_, o
5 o Al iy sl @u}x\u}\ .

ESP8266 - Ll &gk, jadiva Juassi
DAa e
(bl 7 saa) LAl gl ) pedis: pliudl ¢ 58 0
(b 7 ,34) AO «GND «VCC :pubdll CBla i o
clsd 3.3 adiual 22 ©
ESP8266 (A0) <l (s kbl J saall user — Ay kil 3 La) :Jlai¥) o
(ESP8266 Luski ds sl 4 il L5k ) jadiivse ban 5 (e 43 Sall 330000 Jeasl o
Deshill 3as sl (Vee) s 3.3 a3 sl sk 30a 1 VCC S Jaasl o
seal dll alasiul; ESP8266
gud Al 5l 45k 325 5) GND S Jeasl o
Jsnall Gus0) AO el 4y jill Ay sha  sas 5l (bl 7 jadl) AO JiS duasl o
(Nl 1235dy ESPE266 ol 335 ] (N gl

Al A ghay adiia el Al 3¢S IS

A ol L jie Ay ill Ay sha ) pmidiiens Ji g 258N (8 padiadll i 2 Ayl ol e
[ESP8266 2Saill 52a 5 & (AD) (<8 (shlll Jsmall (s s padiu

ADC 2,5 machine ¢«

AQ = i ye & i paiils o 2 35 # ADC(0) = Soil_sensor

8l bl Jsaall 4 e ()8 s g aadial g el (e UL T 31 @ L e

U_’L‘M\ @;j soil_sensor = apc(e)
1023-0 25 # soil_sensor.read() =4l T e e e e
GUly a jal () <« dgda 5 a0l s (REPL b il Gy a2l e “l T i eamaarvacar)
i) e g
("Soil moisture value:", value) =

(Al ¥ Adla) 5 patisall 36 Al ddls 8 o @
:while True 4als Jals g all g 3el @l 0 S Cal o
import time

ADC 2,5 machine o

(AO — AQ) il A sha ) jadiue gl 3 #
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ADC(0) =Soil_sensor

(gl Al Aysha ) palivee Al a3") S
:while True

(1023 - 0) ool dagll 3¢) 3 #
soil_sensor.read() =4l

pall dadll (o #

(“Soil moisture value:”,value) sl

il se) 3l Js o) 5 5 ali# time.sleep(5)

olid) g 2SI Jaals

(58 B (FB) dadill ) o 5 (oaaill paill Béal - o
:Q.._mlaid\ C.;a.'a\ celdaal f'_uh d\; ‘; 0]
(AO — A0 «GND — GND «VCC — 3.3V) <l (e iailly o
((Jread) dapmaall a8 0 (5 bl Jmall 48 )l aladinl (e @il o
Jsaa e (s 5ins ESP8266) (s kbl Jasil Laié AQ il e Sl o
(dadh 2al ) 5kl
bl pan gUadf aaal
o sladl ods Giany ol jeiusal) 5 480l Saill ) ol aa Janll i Adlide jilias (pe slad) Lis 8
CMaa s gl @bl GPIO Ganb alaaiul sl Al of 4S Saall < lua sil) e 3 ea VL sleia
B Ly e 0SBy AW Gaad) Ll m sl A8 e S pre f dagaia e gl
2 GPIO (sl a0 5l dpdadl cUadl) ol cphadill olais Jie delpall claaf elly b
Jodii a8 aandl) U Jasdal) ¢ g pUndl Chaad o) jual 5 AhlA i o) il gl all ff dasaal)

o 363l Aglaa 2ie OSError s <ModuleNotFoundError Jiw JSUia ;‘Lks‘y\ XY
REPL aSaisaa s b il (i e aae ddaliy 5 ¢ jaliiusdl)

sl maail Ao Lhal) ¢ e asiiu

il aliyall (i (lSe paail Aol &l e Caal o
("Script began") <is/

("Sensor initialized") </

("Reading sensor data...") </

53gaY) CBlua i (a (ha

dxnall GPIO Gy Jaiiisall el Jpa i o S o

plasinly plSaly Al gus 50 (GND) (2 )¥15 (VCC) 4kl bagha o o L5 o
saaial) Gl les

i saaaSl) Alausl gy 48U 5 e (S8 38 pSaid) Juasi e Sl o

CiliCal) g 3681 3 i) cllas A GPIO (anld Gldlae) (e (3l
L) Ol sl pe 258N 8 GPIO b a8l (3ilkai (e S @
(Jwa20 machine.Pin.IN :Jk) msaall pagll (0 (3883 @
A eladl (50 A 5 g pall S o) il e X @

import machine

import time

import dht

import machine
import time
import dht

£LadY) i) 8 jeaY O sy Cliglai ol
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Saidl ) (ssd1306.py «dht.py :die) s Jlall claSall Juaad e S o
a0 a0 13 gl

il dualdl) Jadal) @8 g pUadf dallaa

(A e 36l 3l J ol OSError slaal #3lal e
time.sleep() alaaiuh dulic il jalidila) o
‘try-except JiS Jaly jedindl el B calas o

sensor.measure()

temp = sensor.temperature()

(temp) s/

except OSError as e:

("Sensor read error:", e) S/

Lealal g UCial) 59

::—U:ii c—‘*“-‘x i s Jawy Liia) @
Ailaa S Cd Lﬁﬂ\ Uadl) 1o
Al o3 Al Y o

il Gl ) Al

Gl e & clibd) ¢34

Aghia 5y dandal 5 O yirie sland a2in) e
temperature_celsius = sensor.temperature()
humidity _percent = sensor.humidity()

Humidity: 40.9%
Humidity: 40.7%
Humidity:
Humidity:
Humidity:
Humidity:
Humidity:
Humidity:
Humidity: .
Humidity: 40.8

B gl e sl Xy from machine {aport ADC
Q\AM‘X\ :\AE‘JAS é‘}é ‘; Qu\:u]\ O.I‘};J 2:\3:15 C-)J o soil_sensor = ADC(9)

[/ = o:)/‘);.” ‘;'AJ.J 4;!/9/‘)5 moisture_readings = []
/] = J_/}L_)j/ ‘_,/;/-); print("Collecting soil moisture data...")

while True:

value = soil_sensor.read()
temperature_readings.append(temperature_celsius) e s i
humidity_readings.append(humidity_percent) ik i RN

oisture
print("All readings so far:", moisture_readings)

time.sleep(s)
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data_string = "Temperature: {}°C | Humidity:
{}%".format(temperature_celsius, humid_percent)

import time
from machine import ADC

€l S o
tbe) yall 4118 C\)A\ Judls L) @

soil_sensor = ADC(@)

moisture_readings = []

print("Collecting soil moisture data...")

(data_string) S | white True:

value = soil_sensor.read()

moisture_readings.append(value)

print("soil moisture value:", value)
print("All readings so far:", moisture_readings)

time.sleep(5)

SR i o Al i) g

cilile ) bl (S o

LS open('data_log.txt', 'a') slasinl
file.write(data_string + \n’)

ESP8266 - 1l cilildl JUsi Ll data_log.txt o sl JS dilia] s
JEVECRRI PP 3 SVEENE OV 1 -t

i Bale 3] dyshe i i (R 83 5380 ()35 A L) ESP8266 1kaadhe
Wi-Fi (MQTT/HTTP) e W) 5l SD iy ) culill Jis

import time
from machine import ADC

soil_sensor = ADC(B)
print(“Logging soil moisture data...”)
while True:

value = soil_sensor.read()

data_string = "Soil Moisture Val
print(data_string)

ue: {}". format(value)

with open('data_log.txt’, 'a')

as file:
file.write(data_string + "\n')

time.sleep(s)

£LadY) i) 8 jeaY O sy Cliglai ol
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A gally iy 3.1.2

aaadall 2 .8

5 guall

<) g

dase JSI1

ddase JSI1

eilie da 51y AALE e (il JigneS Jlea
(D5t s Jpudli i adle Caa) )14

USB ie) 3550 J sena yiguas

«Thonny IDE s <Python 3.8+) 4le <uia
CP210x / Jpuis el :USB Jiand el s
il & 3] s s «CH340

(b yall/lay jasll

i iYL Jod)
WiFi 48 alsie) cilily ga

dase JSI1

daxta (e

oSl i Al AL el 5eSU alicas B juan
(Sl g 5eS)

2 yanse Ay oy

e USB iy cil 8 0 s )i Jsae

ddase JSI1

Gl Sall 545 aalia

gl i b il Jasdid (a5 o (8 Y A e Laa elgilS Ay g 8 Adlie Cilaa ) geiial Aol AlSa) e Ay ol ) L) Sl ) 2
o=ie e J8 e Lt Gaal 5 A Aaal e g LS (55 0 8 1SS (gl uiadl A5 oa s s e GBI (on i ciiall o) 8 ] udas

RICNERY-TESWRTP TICTEA SR,
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ddasa <11 AdlsS c‘._.s.:':\),\ CL\LSSA) a.:h.&l.m‘ U"_l\jj 2\.1:_94“
N o ESWPSEE
{ SMl
ddaadal) (o Jsl) dpast) Cillgtiacal g ) gall
1 Jis) ESP8266 sk & !
(Wemos D1 Minis NodeMCU
(il JiS 4l e aS) 1 Micro USB «lly Ji<
(s ol QIS il
1 DHT22/DHT11 _lediu) 3as g
1 Ll &gk i 3aa
1 seliall ladiul sas
5 LED zubase
Leie JS110 SAS10 5050 ST a5l 470 o sl
es)
2 Ll )i sasg
2 alayl/Jaeidl) e

£LadY) i) 8 jeaY O sy Cliglai ol
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colaida )

i S 4a )

(LS 85 ¢ ,Sa- ) uala Ja 53 DL

\

Ol ale Y AL (sl o sl 4y jlay
18650

ol Bale Y ALE G gl & gl 4y ey Jala
Al ae 18650

LB 5 8 SeaY ¢l Sllalat
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2 Sun gl ppil jpias 3.2
oSl andlll 3,21

:@JL'\I\

il ol

Vs

s LY ) iy aan o gual LS -2 UK Saa gl pulaal)

alail) g/ il

Jiom s o8y omm JS 35 Aal (IDE) AlalSiall y phail) s e yall i
¢ USB _«= ESP8266/ESP32

¢ REPL Jae (o5 Jleall (555 GLES) (e i yall (3385 Ja

$daial g Cale dyaniiy adain g PY Doy 133a Uy i i yall Ll Ja

€ ) paill el 3 (Laiioaall 5 28 5l 5 ¢ Sleadls aualill) de 350 SISl el yall 3 siul Ja

(("loT Data Acquisition Script Running") <isl) sl Jlial sl x8 yall (i€ Ja
S B rlab oaall (aill Jady

Ceman JSE aa ) il 5 4 glhaall il jafiiaaall 5 dlid) LSl e yall 228 Ja

Js i ModuleNotFoundError Jie dlasl zlle 5 o) i) @ e wd el jia da
?L@j).\;

faaell J Gunlbdll Blail 5 « GPIO Gasbia 5« jaiinall ) 5l e yall aal ) Ja

el 0L Axl pasal A0S

&

Ol 5 Sk plasiuly el

¢ GPIO 2 dae) &y 8 la ¢ DHT 11 Jadiss Rngi 3 S i yall S Ja

90)&‘}&‘M\%6\MUDHT11 ML)‘)‘;Q‘:‘&@J@:‘)A‘?G&

Sel il a5 (a8 (5 B U ymal) Al Al A sk mcdiana Aigd 258 eyl K
a2l

S ail) sel Al a s ad )l (5 BN J gaall aladiuly o guall aiivie Aingd 258 el i€ Ja

GND 5 VCC U plasinls ESP8266 aSaill aa 5o DHT 1 adiise iyl Loy ) Ja

iaaia il

¢ REPL 3 &5k lls 350l Aa 53 e s DHT 11 aiivs ciliby sl il 3 S iyl Ll

QLMDAA_\\)PE&ABM&@M}}M\B;‘}G&)AMGAJJA

8ol il 2,8 iS5 pranam S ESPB266 wSaill 52 52 i) &gl jadiinss e sall Sy s
€ yeions JS & U ol page

L@U@Ec\ﬂ}ﬁ&\W\Lﬁ)

L e 5

Z8LY L hi s GPIO Gty ol jaieadll Jinm 55 (i 68 3620 3liam i (50 ok yall a3

$iaaall
3 il Sllec s Aladl) YT e 2550 3 GPIO oot il 55 3l G el 33
A all 4l

(sl try-except alasial Jie « jaiiudl ialall Juill cd 5 sUaal mijall glle Ja
S A 5ol il Jid sl ZSError

$ellad¥) mpnaal Jas 8 Cladlal) Gika g sladV) mid yall BaY Ja

clitall — cldas] C\_\;..AB

8 (3 sl st ey sial) 51l o 1) Ay ki 8 _ainaall el sediall 5 O

ClalaiV) A8yl il 8 8 Lgi3a s il lae e saaeia el i i yall pln Ja

fheliball J8 daal Judlu pladiuly sial g ) JAY clbilall =l jall (g Ja

N e ol ESP8266 o (data_log.txt) cale & ciliball wd jall Jais da

i 2530 L s i) Sl B ) e O

PLadY) i ) 8 5eaY Ol il sk
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il gf alidl) anil) 3,22

S

s dial) an)

el

:@;ld\ P

Clily e pagual AU — 2 AL as gy Alaiall apdall 200 el paes 3 s jlaall Juadl elol Cadl 13) D 5o o yiall yiag

s L) e )

(f) ¥

Ja sal)

axfill jla

O

oLa o (i 4883 20 (gt b 50 misall & of o
Adsidl skl 4 3 MicroPython ae s =i Lais
GPIO (aly Aty dyslhaddl GliSal) ol 54l 5 <Thonny IDE
Ll el alatinly Juaiall el Aigdy dagmaall ¢ loa VL

g&;i Ol 3_.;“1_;.«]\

il zlindl sl

M.. aj

2 o o Jil 5l d380 20 st b 508 el ¢S ol
il Gl 26 3 MicroPython = » o= 2 while 4da
dxie ) 38 Al 5 () S Gl jle Shaiuly REPL (& 7 s

o« Lu...n.\]“' al) )\)ﬁlm\ UL“A &l\\;\)ﬂ\ u,p@\.m

Lo ye 5 bl aes

dﬂm;ﬁ‘%c‘dﬂjiéﬂ\éd100@&c\3d@¢5ﬂ\0}%01%
aSaiall () e 2SN 5 Aalall a8l (e BRI 5 DY)
Ll e 3y e pead el dac) 2SS 380

il 5 3¢aY) Jua s
Leie

LS o (8 5l 4883 15 Gt b D8 mdoal) 05Ss o ey
GPIO (il ) MicroPython 4l ae oai dasg
oams lial Al Cullad alasiinly bl T el

slhadl 90 REPL (b ¢ saa 0 8 dlall jriianall iy

SRS g
4..'4‘)9}

el A

i o (J8 5 38 10 (s D8 i all 5 O
@MSQ\}LA@;L\LSJ s‘)w\&bhd@;;m‘&d;ﬁ‘fm RO
e il g b el AVlall asd Glld 3 La dusgiadl eUadd)
el < jle aladiul 5 Sl )yl Gasd s (GPIO iy oS5
0352 el paill 2 e Ul efry-except dallas Gulais

REPL & dapnaall 80l jadiiveall cilily ia e g sladl

;Lbii C_JMS
bl

G\}m‘;c‘dsi}i@é\sq10O}b¢‘;‘\3ﬁc_sﬂ\wswig*
Apiall 4l il aladiuly Lol B IS (e mditaaall iy
ULl Gty ddauialy dpand QD Gl jaate A bl o aS
3 e g dagaia el 3 2SU REPL A Lo e 5 ¢z s sll (ol

elaY) e i) dallas s Juaal) o Judaill daidie

() 225 0 JEaYl p2e e L

() Sl

r

C_}‘)\:\j\

spsiall & g

@Jm\

toiall a8 g8

PLadY) i ) 8 5eaY Ol il sk
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Y b akaill mal yul) yghai 13 LU Bang 4

3 daagll ccupaill Jlea 4.1

il Lga 6il) ¢ galaad) 4.1.1

g gllaal) culSlgtinuall g 3 gal)

NodeMCU Jis) ESP8266 _:ski ds 4l
(Wemos D1 Minis

«ilily JAS il (e 35B5) Micro USB @ity JiS
(s S 2 e il

DHT22/DHT11 ledinsl as

slal (5 giua Hladiil Bas

Ll Ak Jladind 3aa

Unndl) 3elay) e 30a

& 18650 il sale Y AL () sl o gl 4 Uy
Jala

LED RGB pusbas

LED eas

e glia

D) e

Lasall i sas g

S & e

aie i e

H s 32a5

COla je Baa g

YEUSIPN

P ES PPN

(S-S ¢ 8- A) aala Jya 55 O

cld 5 cld 3.3 il da sl A8l a5 3 saa

+4, glhaal) <) ga¥)

Laldy el yignaS
S 5 il

daxta (wlide
12 e )i Jsae
<l 8

Gl 5 alue i Jsne
USB 58w Miay

i sSall ( 3a0 Glia
(dilsS s‘_;c\).a LL\SAA)
(Dl pdals

el 3 el 8 12 4
isi

sL Sl 3alcas 3 juan

do A A Al  A5SLL)
Sl 5 5gS)

- adaallfcl k) il

OOdall G FL Aaly aSaS al y LS
4 yhall 5 56a Y 5

2l s ey Qe aSadll shie gl
Lsodll e

el 7 Al/JsA Mla aladil
sase daed dls res GPIOs
PWM 4zl

YLl aladinly oSl laie (st
Al 5elS (o ae 5 gy

sl ad g
(e 4X5 A s dalea 4laly e
= e

sl 5 580
G~ ik

Badxie Al 4eS (ulia g eiilia

Sdide Al Culie culi iR Gl
Sl Y

¢ yisaasll 3 jeal gl aalie g ailka
Gulill AW algadly el Y
leal

Sl 3a8 5 aekaill )yl 5 4034
il 3l g 5 A 5 ST

Al Jaly (L clsls ) 495 ddkie
Ll dpsha ) il 3 jeal Ly

48 jhal) 5 gl g cdladall ¢ sy A3y aSad al A4S

sl Ay 38|
.Thonny IDE 4LaSiall  shaill 4y Ja

5 5uaSIy USB Yis yc ESP8266 ishidasl Jiay e
COM iiia e ol (pe 5 (ESP8266 s 5i e 3SUi o

Ay gllaall uliiCal) o) i)
& Saill Time 4ie aadind s PWM s GPIO 4 Saill Machine 4 aaiiud
il 5 ol il

A 5 < )

Sl zmali sl n () Sy il gl o

[
import machine

import machine

import time

led = machine.Pin(2, machine.Pin.0UT)
relay = machine.Pin(5, machine.Pin.ouT)

PLadY) i ) 8 5eaY Ol il sk
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import time

pasly aaill el yal) Jada) Mandy Jaia® jid) 3Gl e @) e
z= ¢l control_actuator.py

GPIO suba dgiy poathy 8 o

il Dl )i @dall L oSatiin ) GPIO el vl o

led = machine.Pin(2, machine.Pin.OUT)

A oadl Jadia o Ja jall

relay = machine.Pin(5, machine.Pin.OUT)

Jaie JS0 dia g5 4ol 5 Ol e slaud padiul @

() aSatl) ghia Gis)

4dldy) 5 Jadall Janiiy 1) e

LED gluae J2i # led.on()
saal g4l ki # time.sleep(1)
LED zluas (A3 #  led.off()
time.sleep(1) tpory aenine

ddaue Aaal g dals cLaL el Hil) o

led = machine.Pin(2, machine.Pin.ouUT)

Whlle True relay = machine.Pin(5, machine.Pin.oOUT)
led' On while True:
("LED is ON") </ S0 e o
time.sleep(1) e st

led.off{() i 1 e
("LED is OFF") <! e
time.sleep(1)

Ctrl+C axdin) ¢ 568 8 diil) o180 4lgaD) clilall CaliyY rdaguas

dlas g Al (ail) Jads
JaSal) dlaiul 438 jal S5 e el palll J23 o

bgpdll Ao Ul b gl Jauddl asadll ghia jLad)

Ahiall LA i) gl ) (L]

test_control_logic.py. «ale (il 5 58 AlalSiall yy skl 4y =81 @
AW LKAl o) gisl @

import time

Bl " lea Ala" gl 8 e

"device_state = "OFF

‘bl LAY dals (S

count=0

while True:

if count % 2 == 0:

device_state = "ON”

e

device state = "OFF”

("Loop:", count, "Device State:", device state)
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count +=1
time.sleep (1)

il il 35 e
REPL @ls )aslay o

A

if condition:
#action

e

#alternative action

d jlaall Ja gyl Sy
(32anie YIS i) Aldfxie Jag i Adla) @

rdie Ao BSlas o -
25 = jaiad) ded

120 < miiaall dad S 13

[1] !”' Sl ;J.LGA_S‘_;UB

Y

il Jind "GlE" = leal) Ala

U Ju e cdtia g9 dauial § &l yixia elau e\dil.u\ Jaadyl (e daal
Aasie 3l pall As 0

PWM 4aill ya e Juwai cla jia g GPIOs dalad) g g All/J sl Blia aladiad

GPIO il b aSail) 38 cuis)

(gpio_pwm_control.py) s Gae y U (il 5 8 ALSiall ool 2 i) o
Q\.}SSA]\ AJ}L\ °
import machine
import time

g AS GPIO pesndng o

led = machine.Pin(2, machine.Pin.OUT)

LED »iise Gilay g Jondil (uguall A oSa3ll 0

led.on()

time.sleep(1)

led.off()

time.sleep(1)

36 daa i bl da i el ) s Wl "()iS" @l e aadiul e

(PWM) L2 (a8 Jaaas (B psadl) 348 S|

s (e A bl Cla jadl alSlaad 48y HkS (PWM) 4l (aje Jianli 7 0l o
Al LAY (e 5559 s

:GPIO wes e (PWM) daill i je daadis o @

pwm = machine.PWM(machine.Pin(2))

Foa & e syl laal # pwm.freq(1000)

Aoyl GG G aSaill Jaall 550 Ji6 @

for duty in range(200 ,1024 ,0)

pwm.duty(duty)

("Duty cycle:", duty) <«
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time import machine(0.5)

import time

.Sleep

REPL & <ila il Ba¥ s oaill mdisll J2d o
(PWM) Zuall Gimse Jpas pladiads LED glame i 1 AT Yl 03a @
pwm = machine.PWM(machine.Pin(2))
FoasdS1 054 pwm.freq(1000)

while True

g shullsaby#  for duty in range :(100 ,1024 ,0)
pwm.duty(duty)

("Duty:", duty) sl

time.sleep(0.2)

gshudl Js# for duty in range (100-,1-,1023)
pwm.duty(duty)

("Duty:", duty) sl

time.sleep(0.2)

ABUal) 3oUS Glasa pa B 3gaY) cLall aladiuly aSadll (hia Cpaad

53¢l dlae)
Jsenall yisnaSlh ESP8266 Juasi o
ESP8266 4a sl Juasil (kaié pacd JIS () USB wbily JdS aadind o
Jyanall yisnaslly
S .
il < Gl lall < Gl oY) ) cadl e
MicroPython (ESP8266) 2~ o
(Galils 48l 25y 30lally) meamaall COM e bl o
il da e 3 il Juass o
:GPIO z A< e J& o
(Q220) 4 stiall J 31 ikl GPIOS5 (D1) Jesas
(Jashll Gas2dll) LED J o sall Gkl o laall ) Gkl Joa
(58 0) YU (Lpadl) Capkll) LED 3 Al o gaall G Cakall Jaasf
(PWM) &aill = e dai e Jie o
sl 55 Gl GPIO14 (D5) Jua sl
(SR aa) i 5 aja 5T <l @ VCC « 3.3 st
GND <« GND &
haa 5 idaY) Slea e B o
(GND) = Y1 ) AYI5 «GPI04 (D2) ) aals s
(35S0 3 2l Cadl a2300))

A asail) ghaia i)
GPIO pSaill (3his o MicroPython 4al s g US55 el o <38 @
PWM

(e st kit

from machine import Pin, PWM

from time import sleep

led = Pin(5, Pin.OUT)  # GPIO5

servo = PWM(Pin(14), freq=50) # GPIO14 for PWM
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button = Pin(4, Pin.IN, Pin.PULL_UP)
while True:

if button.value() == 0:

led.on()

servo.duty(40) # Example position
else:

led.off()

servo.duty(75)

sleep(0.1)

&5 2 Main.py el calall Lads) o
380 Jaanil F5 e daal i "Jonii (358 8 o
il 5ale) e Ak Ghidl 2, ESP8266 of 0o St o

Lol of da sl asca sale) die UAlals alinds slades 3 SN () LY

Oneadl) dules

3 eayY) el (il

faisia o8 LSLED Jdsedelibda o
flaall Ayl 3l () sl S paa day dd - o
Sl VERY) &5 Ja o

DoY) ) el dadlad als el i Al

[ )

Sl dpaalls) e o

8 pilie eVl menaatl Thonny REPL & 4Lkl < jle aadiul o

Jeadl )53 28 5l haiall cilgic Jaual o

il el a &I Jie o

w S e L) e Giall acf

Lgahaiall ol i) o ol jpal) 38 8 Cladedll adial o

?ﬁ é\ﬂ ( 2 J\Ja.a}“ 1 Jlaay! d.\.A) Bzt Gl laal dgag ‘_A.c uan e

skl
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Agally i) 4.1.2

ddaadlal)

3 i)

5y guall

<l gy

dase JSI1

geilie da 51y AALE e (il JigueS Jlea
(OS Dsains Jaandi ol e ufia) 304
USB ie) 3550 J sena yiguas

«Thonny IDE s <Python 3.8+) 4le <uia
CP210x / Juiss el o :USB Jsalii el s
Gl 4 )la) ClaSla s «CH340

A alaie) il e ccibina allfldy Hal
(WiFi

ERPN I I

one < 1 2 yanse Ay oy

dase JSI1

ta USB i cilsh 0 jalie i J sae

ddase JSI1

Al g8 12 e i Jsma

) i 8 i) skt liam s ke (S0 Y AT e Laa elgild Ry o1 8 Aaliaa clan o el ot Bl ia 50 L) L Al ) 3
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SLed¥) i ) 8 JeaY 05l liulss sk
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ddasa JSI1 Gl Sall o 538 galia

ol Juad U811 L + JSI ) jul 3 1l 8 12 ay jUay

ddaaa <11 @ﬂ\m&ifxﬁmu\ﬂéﬂh@sw

(Sl g 5esl)

ddaadial) (Masa JS1) 4ast) clslginiall g 3 gall

1 Ji) ESP8266 sk 4 !

(Wemos D1 Minis NodeMCU

(il JiS 4l e <) 1 Micro USB «lily Jis
(hadd ol QIS (il

1 DHT22/DHT11 _ladin) sas

1 Ll (5 e _)Lu.ﬁ.u\ RO

1 il dysh ) lediial Baa

SLed¥) i ) 8 JeaY 05l liulss sk
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'Sc\.ab:}” J\.uﬁh\ Baa g

RGB LED

LED cuitas

e U 10

o3l LS 10 5l SLS 1 ol 470 cilaslis

SN e

Ll i sasg

alayyl/Jaadall ~Lida

A )i

-

aie L jaa

t\m‘ "B.J;}

H s 3as

o=l 3 Jomd 1 1

A 12 e

SLed¥) i ) 8 JeaY 05l liulss sk
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3 San gl el ylaa 4.2

S anill) 4,21

;@Jm\

1 dial) ol

Vpas

B4l alaill mal jul) gl — 3 AUSY Bas gl julaall

alail) g/ il

Aask Lelyls ThONN — sl (IDE) ALSiall _y shal) &y e jall 8 o
¢ USB_se maa JSESP8266

frnnall COM 3ix e Ci5aill ;s ESP8266 abia) i jall i Ja

Jic) gl 5 asls adzin 5 oSl el yd s 5y Calo eyl Ll Ja
fcontrol_actuator.py)

¢ il malill el 3 (machine and time) 4 sthall cilaSall gl ) o sivl Ja

eland 5 mnall dlaal) ey aladinly Ciall GPIO Ganles a5 e sal) aas o

fhiia dll &l pziall
time.sleep () 43 phasiuly Jatiall g 5 Jonil bl (S5 3haie el al) S o
frunaa I

¢ Jadiall Aolaiul (he (583l Wy g ddav m“,:«shc_:;)d\tmmﬁ

¢l Jae A1 pal alanty Gl Labny i yall o8 Ja

Osb Aal aSaS mal A
3\.515_))::1\ B‘}g.;;\f\} Iy FIVAL]

Saill shaia JLEAY (sl Aaly Gaa s Ul iyl Liil Ja
f(test_control_logic.py)

fleilSlae G a G Sleadl Vs g A 300 LSl el yall ) sl Ja

¢ REPL (8 cila il pa e 5 dgilaiall Ja ] JLEaY Al el yall i€ o

tha sl e 2l leall el Joail s JS jf-elSe e el paiind Ja

ey )il ol jaiinal) o BlSlaay a8 i Lyl 5 Alaxiall oy i) e yal) J3e Ja

Seiiln 5 3 5S1 36l )8 AL auail dpha 5 il yriia sl gl yall aadial Ja

S“~ :.ux S wX\ .~] . ‘)\-}35\
Lbgyal e 2l s jeaY)

(LED zabas Jie) sSa38 36l 5 cla 38 GPIO Ganles Lagls e yall a6 Ja
¢ (off) Sy dgda o5 (ONn) Jedall Ak y aladiuly

95 36 Y) Jra 5 ade die Sl jaY) (N 3L deldall @ jle i jal) S da

33 T s GPIO s e (PWIM) ) (e iyt gl e yal) A8

i Madiall Ao puv sl B 8 aSaill Jandl 3550 i yall e o

U5 (PWM) Gl m e oond s it g 3330 L i) il cdyall S
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A0l Ky REPL 3 (PWM) Al (2 e Jioad s e guiiall Y Ja
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zoANJ A dalie aladsul
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il gf Aldl) anlil) 4,22
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s dial) an)

el
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pndil) jlana

Lis g L) e il ) 488y 15 (st (8 D8 b el 06 o)) ey
«Thonny IDE 4lalSiall skl 24 8 MicroPython 4sl oas s o=
336yl o il GPIO Gaale dhgds o slhaddl cila€all o il
Ails e Ledla) 5 55eaY) Judil Aail) ghie Jiy S, )kl

olhadl 550 REPL Gila yae JYA (e Jsrdill) daa (g (38l

Gl S el A
Sty Ea Ol
8kl 3 361

Lain g ol o (S8 5 488 15 Ggme (B D el oS o
«Thonny IDE 4llsiall , glaill 43y & MicroPython aal sy o
Gae s Alllae i Jlea Ala e dias by ae while dila 4,
coaadll paill 2w print() @ike ahiiul REPL 4 leal) dlla

sladl 53 byl shaiad B85 mana JS8 Jleall Al s (g Rl

oSaill shie il

o093 gt e o8 ) B8 10 st (B D el OS5 ol e
Ul s e el Sadl Jlells e G e 3l GPIO
Glazsaaaill o) yal 5 leadlal s GPIO sUsal Gilisiul 5 ((HIGH/LOW)

A

GPIO sy (nsS
408 1) 3 3¢ ) A aSaill
alasinly
MicroPython
GPIO ¢Waal waligiul
Leadlaa) 5 Anilall

zoae dae) Lo (Ji 5 38 10 st b o8 mdoall (5S of can
AL Ll sy 21l o Jaadl 3 90 Jasa s «(GPIO w b e PWM

G dawd, L)
Sl b Saill PWM

o) als deadialy PWM sUadl aliSinly o jea¥) (e ddaadlll s bl
Daditan Jua i e o J8 4883 30 0 st B )50 i pall 05 oiw&.—taa pSadll Ghie Gaas
M o IS (B Sl iy aSat mali y Jaead ‘ESPSZG@ - Jaday | YL pladiuly
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) Jalsill ¢ gl aladiialy ASuddly Jual) pL&S) 14 LS Saa g

5
4 saagl) - il jlea 5.1

Gl L ol aleal) 5,11

g gllaal) culSlgtinuall g 3 gal)

Jix) ESP8266 nskidas e
Wemos D1 s NodeMCU
(Mini

e xSb) Micro USB wlily JiS o

QiS5 e (a5 el JAS

(O

DHT22/DHT11 _laiiul sas

clall (5 gicea ladiind 3aa

Ll &k Jladind 3aa

Al sl et 3aa

Gl sale Y ALE ¢ sl o gl 4 sy

Jels 22 18650

RGB LED gbas

LED mubas

il glia

oS

asall i sas g

il

B8 Cila gl diliall laiind 3as

4 paall

P ES PPN

-8 S ) uala duasieDll e
(52

3.3 ladll da N A8 dlae) 3085 @
Gl 8 B el

14 gllaal) ¢ ga¥)

e iV Juadl @

Qaxta (wlhita o

Usanady @

Gl 12 e S dsne @

i g 5 s JEidse o
o#aa USB

Gl Sl (A3 Glua e

ClSia) dpulf @l sl de gane @
ALl ;b)@Sﬂ sdicac B juas @
(Sl 5 yeSI & Hal) aa dal

U A PEATF

Cui i) 3jeaY ASEl Glalae) A e
sy

doasil (b Glidne p pasai LS o
Aladd) claidl 3 5eaY)

Al ) glels ol jaditial) clily J&5 @

Al aesll Jlai) ladl CaliSinl o

eadlal 5 i) Jas

i) b e
8360 ¢ e 4X5 Ay di dala i) 48 2

Al 5 3280

G~ ik

Bawie AlseS ey il
‘ S

ofide Ay Culie yll oia &)
i g Y

¢ yisnalll 8 jgal sl aalieg ulsa
(shandl Gaadaill Ao 531 o) sall 5 el 521
Sl 3ad s askaiil 1ol A3a
il 3l g 5 A 5 ST

o o o |

A pll Jah (i Gl l) 4 dshi
Ll dpsha ) il 3 jeal Ly

s Ll i) 5 gaY Al il ) digs

Csib g Sile aladiuly sl o) gl Cilalas ) ¢y oSi

B 1 A e Bt e Jleadl O e B o

aedi Y) oalaaa 2.4 23 yh < il ASud ae X3 I ) (e S @
(Fabaa 5 22 5 ESP8266/ESP32

sl )0 Juai Lulad Lai (iS) - o

import network
import time

def connect_to_wifi(ssid, password):
wlan = network. WLAN(network.STA_IF)

wlan.active(True)
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if not wlan.isconnected():
print('Connecting to network...")
wlan.connect(ssid, password)
timeout = 10

while not wian.isconnected() and timeout > 0:
time.sleep(1)

timeout = 1

if wlan.isconnected():
print('Connected:’, wian.ifconfig())
else:

print('Failed to connect)

connect_to_wifi("Your_SSID', 'Your_PASSWORD)
wifi_connect.py sl boot.py sl ilall Jaéal o

S Alila ) il ESP ) alas o
S o cla haall (bl ) dall Qo] o

Tlandl) claiall 5 3429) Jpea sil ¢ giks Ay Lma s oo AiS

(ThingSpeak) (sl s dlae) —
Ol sie 4 https://thingspeak.mathworks.com kil Jasl e ¢ 5 0 EEEm——
&l aldll miiaidl [JThingSpeak™ crmes- s~ Suf
lua ¢LiSY Get Started For Free "Ulae fnl" 53 e j&il o
ThingSpeak My Channels
syaa 5l &l «—My Channels 358 yial «Channels < sill) <8l o i
Create a new channel Cromed

Ba g Caal 5 il Gl ) o
(Dl g Ao gha )l Jia) Badmtia el B s A e i€ o
Yl sae Jundl Siay

ledaia g bl LY "l Laea" 5 e @) o
Description @
(API) kil s 4g2) g N

b J zUais «ThingSpeak ) ESP32 5| ESP8266 (» o Jla Y

zlia" (ot Adle 8l (Write API Key) cilinkill daa j dgal 5 44U

Write API ) Qw‘ daa y dgal 5 S Fla Foil g "Olaphill Aas p dgal
LY Legd) z liadu Y ol S ) Bl e (Key Write API Key

Key | HEOBXEH. T w¥"" |

4y Ul (API Key) cliudaill daa y dgal 5 olite o L5 Y rials ddaadle
iy M) Jpa V) et

ThingSpeak ! HTTP Post :0s5ub s Site dady Uaa n Lal cuis)
g IR | U S

import network

import urequests

import time

def connect_wifi(ssid, password).
wlan = network. WLAN(network.STA IF)
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wlan.active(True)

if not wlan.isconnected()
wlan.connect(ssid, password)
while not wlan.isconnected.()

(71 fime.sleep

print("Connected:", wian.ifconfig())

def send_to_thingspeak(api_key, value).

url =

"https://api.thingspeak.com/update ?api_key={}&field1={}".for
mat(api_key, value)

response = urequests.get(url)

print("Server response:”, response.text)

response.close()

alaziuy) Qi #
connect_wifi("YourSSID', "YourPassword')

while True

Ledl] padiveall 501 44 Jlvinl # sensor_value = 42
send_to_thingspeak("YOUR_API_KEY', sensor_value)
time.sleep()

Jalad ol Uamadl
Private View "=l (el cusiidade ) Jil o
Edit Jaxill 55 e 81 o
Laliall Gl gie Caal o
W e 5 0y 5 X s dilall (6l palad o
Save "his" ) e il (it ldie o

Customizing Chart

her chart can be cusiomized, go to your Private View tab and click on the

Channel Stats

ntries: 0
BME280 Readings

Field 1 Chart Options

Ll ) olaly @l i) cililby J&5

£LadY) i) 8 jeaY O sy Cliglai ol
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ESP32 5l ESP8266 J<as«: DHT22 sl DHT11 Jwayl

Gl sl A DHT 11 sbes J301

ESP aa5 & @l 8 3.3 Ly pebealls (el AN VCC (o2 ol @
=294 (GND) = Y deasl

ESP 33a 5 8 GPIO2 ey slual) clily usod Jacasl @

A5 Gl Aal b (e al pladialy jrdlical) cile) B (e (gBa
il paill (S o

import dht

import machine

import time

sensor = dht.DHT11(machine.Pin(2))

while True:

sensor.measure()

temp = sensor.temperature()

hum = sensor.humidity()

print('"Temp:', temp, 'C Humidity:', hum, '%")
time.sleep()

Cral @ gl Jual) dlac)
qu)ﬁu&M‘bhjem‘ ®

import network
sta_if = network. WLAN(network.STA_IF)
sta_if.active(True)

sta_if.connect("YOUR_SSID’, 'YOUR_PASSWORD)

while not sta_if.isconnected():
pass

print('Connected.’, sta_if.ifconfig())

(DHT rdisa 351 85 ¢ sl () o) Aady JLaD Labia) Uinna g L S|
ThingSpeak () <llbal) Juals

M el paill (€I o

import network

import urequests

import utime

import dht

from machine import Pin

Lj& L;/jj/ slaie ) Sbily #
ssid = 'YOUR_SSID'
password = "'YOUR_PASSWORD'
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sta = network. WLAN(network.STA_IF)
sta.active(True)
sta.connect(ssid, password)

: while not sta.isconnected()
print("... Wi-Fi 1. Jlaiy/ ")
utime.sleep()

print(fIP:", sta.ifconfig()[0 J/se «fais")

il o) #
D4 s GPIO2 i # sensor = dht. DHT11(Pin(2))

ThingSpeak APl #
api_key ='YOUR_API_KEY
url = 'https://api.thingspeak.com/update

While True:

sensor.measure()

temp = sensor.temperature()

hum = sensor.humidity()

(fTemp: {temp}°C | Humidity: {hum}%') print

Ll Sy #

full_url =
T{url}?api_key={api_key}&field1={temp}&field2={hum}
try

response = urequests.get(full _url)

print("Sent to ThingSpeak:", response.text)
response.close()

;except

print("Failed to send data.")

utime.sleep(15)

main.py st A0 dais) @

sad¥) 5 cBladl (e Gaaill REPL 1 A) Gl ), alaniiy 3 o
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L) ye gadl)

ThingSpeak.com | Jsaall Jaw o

el alal) ) il glas da ) <) @

S Lgiaan e o ladl) i gl 8 4y sa )l 5550 pall da o cillabada e odlal o
i 15

Lgadual 5 cbibal) Ja g bl Audl) Jlal) lad) Calisig

el s 3e1 3
Juledll L3LE s j3e ) Jpasll @
el s Jila danl o @
"LWi-Fids Juay s o
IP Olsie + "zlat JuaiVl 3" o
dolad) o s o "dlaiy) Jad" o
& ()sta_if.ifconfig aasiul Al 5 [P Glaglas e Gisill 488~ 50 @
IP 0285 i s 2l i MicroPython
16ld () sl Al Juai¥) Jslay 31 ol el yall 138 550 @
import network
import time

el AalaAll Wi-Fi slaie ) <l Jaiul #
SSID = "Your_SSID"
PASSWORD = "Your_PASSWORD"

.def connect_to_wifi()
wlan = network. WLAN(network.STA _IF)
wlan.active(True)

if not wlan.isconnected():
print("Connecting to Wi-Fi...")
wlan.connect(SSID, PASSWORD)

# Wait until connected or timeout after 10 seconds
timeout = 10

while not wlan.isconnected() and timeout > 0:
print("Waiting for connection...”)

time.sleep(1)

timeout -= 1

if wlan.isconnected():
print("Connected successfully!")
print("Network config:", wian.ifconfig())
else:

print("Failed to connect.”)
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connect_to_wifi()

Osil pagai B pladY) dallaa

sana il gUadl Juast of delibs ol jlie dalaly cUndY) Jossi 2d5 @

il sUaal dallaal by (a2 g (e 1280 Adal avngigase @
HTTP

import urequests

try

response =

urequests.get('https.//api.thingspeak.com/update ?api_key=Y

OUR_API_KEYé&field1=25')

if response.status _code == 200.

print("Data sent successful”)

else

print("Failed with status code:", response.status_code)

response.close()

‘except Exception as e

print("Error happened:”, e)
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Improving the Quality and Attractiveness of Vocational Education and Training in Lebanon for vulnerable social groups (QuA-VET)

Introduction

The Multi-Donor Action “Improving the Quality and Attractiveness of Technical and Vocational Education and Training (TVET) in
Lebanon for poor and vulnerable social groups” is jointly co-financed by the European Union and the Federal Ministry of Economic
Cooperation and Development (BMZ). The joint action is implemented by GIZ as a specific Action within the wider BMZ project
“Improving the Quality and Attractiveness of TVET in Lebanon (QuA-VET).” The QuA-VET project has developed this Curriculum as
part of a series of curricula in the Agrofood and Internet of Things (loT) in its overall effort to promote the use of standards across
public and private vocational and technical training providers — schools, institutes, NGOs, and other training institutions in Lebanon.

A major objective of developing and adopting standards in the training standards is to set the best practice defining a
curriculum is to promote consistency and quality, including training taking place outside the framework of the General Directorate for
Technical and Vocational Education (DGVTE). Other objectives in adopting a modular approach are to introduce greater flexibility
(both external and internal) into the VTE system; make VTE more attractive and raise its status; increase participation rates and/or
reduce early dropout; and promote links with the labour market to meet industry needs.

The process to design and deliver training modules can be seen as the process to design and deliver a curriculum. The model for

curriculum design divides the process into four stages connected to one another, forming together what we might call the outcome -

oriented (or competency-based) curriculum:

e Occupational standard: a document which sets out a norm of what people need to learn and how the quality and content of
learning isassessed;

e Qualification standard: a document which sets out a norm of what people need to learn;

o Assessment standard: a document which sets out a norm of how the quality and content of learning is assessed, shortly to verify
if the learner is competent to carry out the occupation;

¢  Education standard: a document which translates the qualification standard into the educational context;

e Training or learning standard: a document which plans teaching and learning activities, considering the environments and
resources required, duration and learners’ needs. It provides detail on each of the tasks and sub-tasks that make up the
qualification.

This curriculum may be used for a variety of purposes, including:
e guiding the development of trainees’ abilities
e accreditation of training programs
e assessing performance and career development
e supporting training providers who are developing or revising basic and advanced training programs
e developing criteria for prior learning assessment and recognition
e providing guidance to employers for recruiting, selecting, training and retaining employees

This curriculum sets the standards towards best practice in the occupation and is developed around a limited number of
Competence Units (3 to 5) grouping together the abilities required to perform the tasks in line with the internationally recognized
best practice of the sector. Each competence unit can be assessed independently from the others and can be acquired in different
settings (formal, informal and non-formal). The assessment of competences will be carried out by a professional entity independent
from the training provider assuring reliability, transparency and consistency in the assessment and in the certification of the
qualification.

Regardless of the size of the project, the tasks must be performed in a manner that complies with Occupational Health and Safety
(OH&S) guidelines and regulations.
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Curriculum delivery

The curriculum is a set of standards that should be interpreted and delivered to trainees having in mind that at the completion of the
training program they will be tested against the criteria set in the assessment standards that are reflecting best practices. Education
and Training standards are the two documents that a trainer will use in the delivery of the curriculum. The education standards set
the overall timeframe required for the learning of the competences set in each competence unit while the Training standards set the
best practice adopted in carry out the tasks by a competent and qualified operator. The Training standards should be considered as
a guideline for the trainer to assure that trainees will carry on the tasks as stated in the Training standards. The trainer will monitor
the progress of the trainees in acquiring the abilities filling in the formative assessment for each trainee.

Necessary materials and facilities

For the appropriate delivery of the training module, it is necessary to provide for the necessary facilities (practical training
workshops), materials and tools included that are described in the Training standards. Tools and materials must be the ones that
are currently used in the trade. They should not be models or equipment oriented to make understand but tools and materials for
practicing the tasks of the trade.

It is essential for learning the abilities of the trade that practical exercises resemble real working conditions as closely as possible.
Hence, the tools and materials as well as the guidelines given regarding the practical training venue are a prere developing,
testing and deploying prerequisite for demonstrating the working techniques by the trainer, followed by exercises executed by
the students themselves. This also means that the number of tools and the material as stated in the Training standards should be
respected to ensure real practical training. In addition, audio-visual material is required to help trainees visualize procedures and
processes that can’t be demonstrated or practiced.

Teaching and learning approaches

The instructor should choose a participative teaching-learning approach, providing as much possibility to the trainee to discover and
practice as possible. The trainee should be encouraged to actively participate in the development of his/her skills through discussion
as well as practical exercises in the real world of the workshop.

The desirable didactical approach of training is characterized as follows:

¢ Instruction is based on action orientation and project based work in groups
e Learning experiences are guided by frequent feedback using the formative assessment sheet
e Instruction is, to a considerable extent, field- centered - based on realistic work problem and situations;

Furthermore, the training standard serves as the basis for the development of a training plan, including:

e the timetable, with the allocation of the appropriate duration of training time for each content and task;
o the assignment of each content and task to appropriate training venue (school/training center classroom, workshop or
company).

Assessment

Based on the Assessment standards individuals will then be assessed in order to determine if they have the requisite abilities for
effective work performance. The assessment of trainees by a professional entity independent from the training provider will assure
also feedback to the training provider on the “quality” of the training provided.
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1 loT Developer: Developing Python applications for loT devices

1.1 Occupational standard

ISCO-08 code: 2512
Software developers

Occupational standard
loT developer

The occupation covers the process of developing, testing and Deploying Python-based Applications on loT devices, with a

devices

focus on data acquisition, device monitoring, and control.
Process Element Description
P1 Developing Python applications for loT | oytput loT application code, functional loT device with deployed

application, configuration documentation

Setting up the development environment
Sub-Process Writing Scripts for Data Acquisition from loT Sensors
Developing programs for Device Control

Establishing network connectivity using Python for cloud
integration

Performing end-of-work activities

Input New product or service, technology upgrades, industry
requirements, customer demand, market trends, project
requirements

Resources Sensors, actuators, embedded systems, power sources,
network, 10T devices, Python software and libraries, cloud
services
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ISCO-08 code: 2512
Software developers

Competence standard

loT Developer

A competent person should be able to develop and test Python applications on loT devices, for data acquisition and device

control.

Ability / Competence

Competence unit . Knowledge
Learning outcome

CU1 Set Up an IDE and Python Environment for | MicroPython

Setting up the MicroPython Device drivers

development Configure development tools and drivers External libraries

environment o _—
Establish microcontrollers communication Serial communication protocols
Import external libraries and dependencies USB/COM port handling

Ccu2

Writing loT data
acquisition scripts

Write Python scripts to collect data from loT
sensors using MicroPython

Interface sensors with code to read and display
their data

Debug data acquisition errors
Extract sensor data

Python scripts to collect data from various sensors
Digital or analogue sensors

Data acquisition methods

Debugging tools

Common error patterns

CuU3

Developing
programs to control
devices

Write control programs in Python for actuators
and peripheral devices

Test control logic to actuate devices based on
conditions
Use GPIOs and PWM outputs

Refine control logic using hardware connections
while ensuring energy efficiency

Python

Actuators

GPIO, PWM, and conditional logic
Libraries

Cu4 o Configure network settings for loT devices Network protocols used in loT (Wi-Fi, MQTT,

Establishing , , . HTTP)

network Write Python scripts to connect devices to cloud

connectivity using | Platforms Basics of Python for loT communication

Python for cloud Transmit sensor data securely to the cloud Structure and function of loT cloud platforms

integration Troubleshoot basic network connectivity and | Data security principles for cloud transmission
data transmission issues

CUS Conduct cleanup and backup Documentation techniques

Performing end-of- | poement source code Version control systems and workflows using tools

work activities

Store hardware tools
Report according to task records

like Git
Reports and logs
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1.3 Assessment standard

ISCO-08 code: 2512
Software developers

Assessment standard
loT Developer

control.

A competent person should be able to develop and test Python applications on loT devices, for data acquisition and device

Competence unit 1

Setting up the development environment

Assessment criteria and
indicators

The candidate is considered competent if he/she can demonstrate a best practice performance
in all the 4 learning outcomes / abilities within the allocated assessment time:

YES/NO IDE installed and set up

YES/NO Python installed

YES/NO Development tools and drivers configured
YES/NO Microcontroller communication established
YES/NO External libraries and dependencies imported

Assessment procedure

The assessor observes the candidate installing and setting up the Integrated Development
Environment (IDE) and installing Python and any required libraries. The candidate configures
the development tools and installs the necessary drivers based on the setup instructions.
Microcontroller communication is established by connecting and verifying interaction between
devices. The candidate also imports external libraries and dependencies as listed in the
development requirements

Quality assurance is ensured through the use of a standardized checklist, and moderation of
results after completion. Assessment time will be predefined and sufficient for all tasks, based
on prior trial runs

Competence unit 2

Writing loT data acquisition scripts

Assessment criteria and
indicators

The candidate is considered competent if he/she can demonstrate a best practice performance
in all the 4 learning outcomes / abilities:

YES/NO Python scripts to collect data from loT sensors written using MicroPython
YES/NO Sensors interfaced with code

YES/NO Data acquisition errors debugged

YES/NO Sensor data extracted

Assessment procedure

The assessor observes the candidate writing Python scripts to collect data from loT sensors
using the provided requirements. The candidate interfaces the sensors with the code so that the
sensors respond and transmit data. During the process, the candidate identifies and debugs
any errors related to data acquisition. The candidate then extracts the sensor data for further
use. Consistency of assessment across assessors and institutions is maintained through the
use of a standardized marking checklist, clear performance criteria, and post-assessment
moderation or calibration sessions to align scoring decisions.

Competence unit 3

Developing programs to control devices

Assessment criteria and
indicators

The candidate is considered competent if he/she can demonstrate a best practice performance
in all the 4 learning outcomes / abilities:

YES/NO Control programs used for actuators and peripherals devices
YES/NO Control logic tested to actuate devices based on conditions
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YES/NO GPIOs and PWM outputs used
YES/NO Control logic refined based on test results and performance feedback

The assessor observes the candidate using control programs to operate actuators and
peripheral devices based on task requirements. The candidate tests the control logic to actuate
Assessment procedure | devices in response to specified conditions. General-purpose input/output (GPIO) pins and
pulse-width modulation (PWM) outputs are used to manage device behavior. The candidate
then refines the control logic based on the outcomes of the test procedures.

Competence unit 4 Establishing network connectivity using Python for cloud integration

The candidate is considered competent if he/she can demonstrate a best practice performance
in all the 4 learning outcomes / abilities:

Assessment criteria and

o YES/NO Network settings for loT devices configured
indicators

YES/NO Python scripts to connect devices to cloud platforms written

YES/NO Sensor data securely transmitted to the cloud

YES/NO Basic connectivity issues troubleshot

The assessor observes the candidate configuring network settings for loT devices according to
task requirements. The candidate writes Python scripts to connect loT devices to cloud
Assessment procedure | platforms as specified. Sensor data is securely transmitted to the cloud. The candidate then
troubleshoots basic network connectivity and data transmission issues to ensure stable device-
to-cloud communication.

Competence unit 5 Performing end-of-work activities

The candidate is considered competent if he/she can demonstrate a best practice performance
in all the 4 learning outcomes / abilities:

Assessment criteria and

o YES/NO Cleanup and backup conducted
indicators

YES/NO Source code documented

YES/NO Hardware tools stored

YES/NO Task records reported

The assessor observes the candidate conducting cleanup and creating a backup of the project
files as required. The candidate documents the source code by adding necessary comments
Assessment procedure | and information to support understanding and future use. Hardware tools used during the task
are collected and stored in their designated locations. The candidate completes the process by
reporting task records using the provided format.
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1.4 Education standard

ISCO-08 code: 2512

Software developers

Education standard

loT Developer

Occupational standard

Developing Python applications for loT devices (ISCO-08 code: 2512)

Assessment standard

Developing Python applications for loT devices (ISCO-08 code: 2512)

Overview

At the completion of the Training Module the participant will be able to develop,
test and Deploy Python-based Applications on loT devices, with a focus on data

acquisition, device monitoring, and control as well as establish network
connectivity using Python for cloud integration

Competences

Set Up an IDE and Python Environment for MicroPython

Configure development tools and drivers

Establish microcontrollers communication

Import external libraries and dependencies

Write Python scripts to collect data from loT sensors

Interface sensors with code to read and display their data

Debug data acquisition errors

Extract sensor data

Write control programs_in Python for actuators and peripheral devices
Test control logic to actuate devices based on conditions

Use GPIOs and PWM outputs

Refine control logic using hardware connections

Configure network settings for loT devices

Write Python scripts to connect devices to cloud platforms

Transmit sensor data securely to the cloud

Troubleshoot basic network connectivity and data transmission issues
Conduct cleanup and backup

Document source code

Store hardware tools

Report according to task records

Knowledge

MicroPython

Thonny

Device drivers

External libraries

Serial communication protocols

USB/COM port handling

Python scripts to collect data from various sensors
Digital or analogue sensors

Data acquisition methods

Debugging tools

Common error patterns

Actuators

GPIO, PWM, and conditional logic

Network protocols used in loT (Wi-Fi, MQTT, HTTP)
Basics of Python for loT communication

Structure and function of loT cloud platforms

Data security principles for cloud transmission
Documentation techniques

Version control systems and workflows using tools like Git
Reports and logs
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Learning program During the classroom standard into lessons the following topics will be covered:

Introduction to loT and Development Environments
Python for loT Data Acquisition

Microcontroller and Sensor Communication
Programming Device Control with Python

Cloud Integration and Secure Data Transmission
End-of-Work Procedures and Documentation

kv~

During the workshop lessons the following practical activities will be executed:

1. Installing and configuring python, IDEs and drivers

2. Testing device connectivity

3. Developing and deploying Python scripts for real-time sensor data
collection

Debugging scripts and validating sensor data extraction
Connecting circuits

Writing and testing control programs to operate actuators and peripherals
Refining control logic using hardware connections

Configuring network settings for device connectivity

Writing Python scripts to connect devices to cloud platforms

O Testing and troubleshooting secure sensor data transmission

Se®E~No o~

During on the job training the following job activities will be carried out

1. Configuring network settings for device connectivity (5 hours)

2. Testing device connectivity within actual workflows (3 hours)

3. Developing and deploying Python scripts for real-time sensor data
collection (16 hours)

4. Debugging scripts in a live operational environment (6 hours)

5. Writing and testing control programs to operate workplace-specific
actuators and peripherals (18 hours)

6. Refining control logic using hardware connections (2 hours)

7. Writing Python scripts to connect devices to cloud platforms (15 hours)

8. Testing and troubleshooting secure data transmission (5 hours)

9. Conducting cleanup and backup (3 hours)

10. Documenting source code and maintenance logs (4 hours)

11. Storing tools and completing reports (3 hours)
On-the-job training placements are coordinated with approved host organizations,
following an agreed training plan. Progress is monitored through regular
supervisor check-ins, activity logs signed by both trainee and supervisor, and
periodic reviews by the training provider to ensure learning outcomes are met

Learning time frame Competence | Classroom Workshop On the job
code lesson lessons training Total (hrs)
(hrs) (hrs) (hrs)
CuU1 1 2 3 6
Cu2 2 8 22 32
Cu3 1 8 20 29
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CU4 2 12 25 39
CU5 1 3 10 14
Total (hrs) 7 33 80 120
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2 Competence Unit 1: Setting up the development environment

21 Training Standard - Unit 1

211 Training guidelines

Ability / Learning outcome: Required Tools: Required Materials and

, _ Consumables:
e Set Up an IDE and Python Environment for e PC & Monitor or Laptop

MicroPython with USB port o [ESP8266 Development
o Configure development tools and drivers ¢ Internet connection Board (e.g., NodeMCU,
Establish microcontrollers communication e Anti-Static Mat ESD Safe Wemos D1 Mini)
o Import external libraries and dependencies e Micro USB data cable
(ensure it is a data cable, not
Training site: just charging)
e |oT device catalogues and
Indoor room of approximately 4 x 5 m equipped with specifications sheets
e  MicroPython syntax
e Wide window reference sheet
o Fire extinguisher
e Many electrical switches and sockets
o Fixed wooden high-chair furniture suitable

for electronics lab activities
o Desks and benches where we can place
PCs, tools, and materials for practical work
o Closet and drawers for organizing and
storing electronic components and lab
materials

Set up an IDE and Python Environment for MicroPython

Download/ Install Python

e Download Python 3.8+ from Download Python | Python.org
o Follow the installer instructions and check "Add Python to PATH".
o Verify Python installation:
o Open command prompt by pressing Win + R then type cmd and hit Enter.

o Type: python --version.

o If Python is installed, you will see something like: Python 3.8.5.

o Ifitdoes not work, python may not be added to your system’s path. You will need
to repeat the Python installation process.
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Y @

Select Setup Install Mode

... Select install mode

3
Thy

Dialoed version 4176
Thonny Windmes + Mac » Linux
Python IDE for beginners )
click her
Thorny -0 x

Select and Install IDE

Open your browser and go to https://thonny.org

Download ‘Thonny’ IDE for windows

Locate the downloaded file (thonny-4.x.x.exe) in your Downloads folder.
Double click to Run the installer.

Select ‘Install for all users’ and then accept the agreement.

Follow the installer instructions with default settings.

Check “Add Thonny to PATH” if prompted.

Open the IDE to confirm it is working.

Verify python installation: Go to tools > options > interpreter

Configure development tools and drivers

Identify your USB-to-Serial chip

o Inspect your board physically, Look for markings on the small USB-to-Serial chip near the

USB port:“CH340G” — needs CH340 driver
o “CP2102" — needs CP210x driver

If unclear: Check your board’s data sheet.

Download the driver

e Download CH340 driver from the website:
https://www.wch.cn/downloads/CH341SER_ZIP.html

e Browse the silicon labs official website to download CP210x driver from:
https://www.silabs.com/developers/usb-to-uart-bridge-vcp-drivers

e Click on downloads tab and choose: CP210x Windows Drivers

Tip: It is better to download both drivers if you are unsure, it won't cause conflicts.
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Install the driver

e |nstall CH340:
o Unzip the downloaded .zip file.
o Run SETUP.EXE (Windows).
o Follow the on-screen instructions — Click Install.
o You should see “Driver install successful.”

e Install CP210x:
o Runthe .exe installer.
o Accept terms — Click Next.
o Complete the installation.

Establish microcontrollers communication

Examine the ESP8266 board to get familiar with its layout:

o |dentify the main components:

ESP8266 chip (the small black square/rectangle).
USB connector (for programming and power).
Status LEDs (power and communication).

o Locate the pinout:

Power pins: 3.3V, GND.

GPIO pins: general-purpose input/output for sensors, actuators, etc.
Special pins: Reset (RST), Enable (EN), Analog input (ADC).
Connect the microcontroller

e Plug the ESP8266 into the PC with the Micro USB data cable.

e Ensure the ESP32 board is not placed on a metallic surface during operation to avoid short
circuits by placing it on the Anti-Static Mat ESD Safe

e  Confirm the board’s LED turns on (power indicator).

o Wait for Windows to detect the device.

Verify the COM Port

e Open Device Manager: Press Win + X — Device Manager.

e Expand “Ports (COM & LPT)".Look for: USB-SERIAL CH340 (COMx) for CH340 or
Silicon Labs CP210x USB to UART Bridge (COMx) for CP210x. you'll need the com port in
Thonny later.

If no COM port appears:

e Try adifferent USB port.

e Try adifferent Micro USB cable (must be a data cable).
¢ Reinstall the driver.

o Restart the PC if needed.Try another ESP8266 board.

Configure Thonny

e Open Thonny.

e Go to Tools > Options > Interpreter

e InInterpreter: Select MicroPython (ESP8266) or ESP32
e InPort: Select your identified COM port and click OK.
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e g o e 1 i i Wi b

Flash MicroPython Firmware

Open Thonny.

Go to Tools > Options > Interpreter

Click on ‘Install or update MicroPython (esptool)
Select the target port.

Select the MicroPython family: ESP8266

Select Variant: Espressif ESP8266

Select the latest version

Click install

Wait for flashing to complete and reset your ESP8266.

Note that if the flashing completes and the board resets without error, your firmware is
installed.

Test Communication with microcontroller

Click Stop/Restart Backend.

You should see: MicroPython v1.x.x on 202x-xx-xx; ESP module with ESP8266

Import external libraries and dependencies

Prepare and upload the library

e Download the library from MicroPython GitHub drivers (example of library: ssd1306.py)
e Save it to your computer (e.g., Downloads folder).
File-> Save as Save on device . Open Thonny
e Connect your ESP8266.
«w« | ® Confirm REPL appears in the bottom shell. This is where you can directly type and run
T MicroPython commands on your ESP8266 once communication is successful.
¢ Go to File > Open... > This Computer.
o wu | o Open ssd1306.py.
Bt e Go to File > Save As... > MicroPython device.
e Save as ssd1306.py.
o Verify upload: In Thonny’s file browser (left sidebar), confirm ssd1306.py appears under
your ESP8266 files.
Test Import

In Thonny’s REPL (bottom console area), type the following:
import ssd1306
print("Library imported successfully")
Press Enter.
o Ifno errors appear and you see the message:
Library imported successfully
then the ssd1306 library has been successfully imported.
o Ifyou get an error like ModuleNotFoundError, it means the library is not yet installed or
uploaded to your device.
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2.1.2 Tools and materials

Tools Picture Quantity" Comment
PC & Monitor & keyboard & mouse (Windows OS 1 per station
installed)

Or Laptop with USB port

With installed (Python 3.8+, Thonny IDE, and USB
Drivers: CP210x / CH340 Drivers and Administrative
privileges to install drivers/software

Internet connection
With WiFi network credentials

1 per classroom

Anti-Static Mat ESD Safe 1 per station

Materials and Consumables Picture Quantity Comment

ESP8266 Development Board (e.g., NodeMCU, Wemos
D1 Mini)

1 per station

Micro USB data cable 1 per station (ensureitis a
data cable,
not just

charging)

loT device catalogues and specifications sheets
MicroPython syntax reference sheet

1 per station

' The quantity expressed for workshop means that the item can be used for different modules in the same workshop, this imply that
two modules that are using the item could not be delivered at the same time. Warning! before purchasing the item it should be
verified if it already exists in the workshop to avoid unnecessary duplications. Also, the list should be reviewed and verified by an
experienced professional.
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2.2 Assessment standards - Unit 1

2.21 Formative assessment

Trainee Name:

Date:

Ability /
learning outcome

Criteria for competence unit 1 — Setting up the development environment

Yes / No

Set Up an IDE and
Python Environment
for MicroPython

Does the candidate download and install Python 3.8+ from the official Python.org website?

Does the candidate follow the installer instructions and check “Add Python to PATH"?

Does the candidate verify the Python installation by opening Command Prompt and
checking the version with python --version?

Configure
development tools
and drivers

Does the candidate identify the USB-to-Serial chip on the ESP8266 board (CH340G or
CP2102)?

Does the candidate download the correct driver (CH340 or CP210x) from the official
websites?

Does the candidate install the selected driver successfully?

Establish
microcontrollers
communication

Does the candidate identify the ESP8266 components (chip, USB connector, LEDs)?

Does the candidate locate the power, GPIO, and special pins on the board?

Does the candidate connect the ESP8266 to the PC using a micro-USB data cable?

Does the candidate ensure the board is placed on a safe, non-conductive surface (e.g.,
ESD mat) to avoid short circuits?

Does the candidate verify that the board powers up (LED indicator turns on)?

Does the candidate open Device Manager, locate the correct COM port, and identify it as
CH340 or CP210x?

If the COM port does not appear, does the candidate troubleshoot (try another port, cable,
reinstall driver, or restart PC)?

Does the candidate open Thonny and select MicroPython (ESP8266/ESP32) as the
interpreter?

Does the candidate select the identified COM port in Thonny and confirm the connection?

Does the candidate access Tools > Options > Interpreter in Thonny and choose “Install or
update MicroPython (esptool)"?

Does the candidate select the correct port, family (ESP8266), and variant (Espressif
ESP8266)?

Does the candidate install the latest MicroPython version and wait for the flashing process
to complete successfully?

Does the candidate reset the board and confirm that firmware installation succeeded?

Does the candidate restart the backend in Thonny and confirm that the REPL displays the
correct MicroPython version and ESP8266 module information?

Import external
libraries and
dependencies

Does the candidate download an external library (e.g., ssd1306.py) from the MicroPython
GitHub drivers?

Does the candidate open the library in Thonny and save it to the MicroPython device with
the correct filename?

Does the candidate confirm that the library file appears in the ESP8266 file system within
Thonny?

Does the candidate test the import of the uploaded library in Thonny’s REPL using import
ssd13067

Does the candidate verify the success of the import by printing “Library imported
successfully™?

If an error occurs (e.g., ModuleNotFoundError), does the candidate troubleshoot the issue
by re-uploading the library?
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2.2.2 Summative assessment
Trainee name: Date:
Assessor name: Date:

The candidate is considered competent if he demonstrates a best practice performance in all the 5 following criteria for

the assessment related to the competence unit 1 - Setting up the development environment

Criteria for assessment Qualifier YES | NO (%)
Install and Set up the The candidate should complete the installation and initial setup of the
, P required IDE (e.g., Thonny) in less than 15 minutes, ensuring the IDE ] 0J
required IDE . ) .
opens without errors and recognizes the connected microcontroller.
The candidate should complete the installation of Python in less than 15
minutes, ensuring that Python is added to the system PATH and can be
Install Python o . . C . O Ol
verified by running python --version or python3 --version in the terminal
without errors.
Install and confiaure The candidate should complete the installation and configuration of the
. 9 required USB-to-Serial drivers and development tools in less than 15
drivers and development . . . ) X ) O O
minutes, ensuring the loT device or microcontroller is recognized by the
tools . .
system and the development environment without errors.
The candidate should establish communication between the
. . microcontroller and the development environment in less than 20
Establish Microcontroller . . o . -
o minutes, ensuring the device is recognized, the correct communication l ]
communication . . )
port is selected, and a test command is executed successfully in the
REPL or console without errors.
The candidate should complete the upload and import of required
external libraries to the microcontroller in less than 15 minutes, ensuring
Import external libraries | that the library files are correctly placed on the device, the import O O

command executes without errors in the REPL or script, and
functionality is verified.

Criteria (*)

Evidence of non-compliance if any (**)

Assessor signature:

Date:

Trainee signature:

Date:
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3 Competence Unit 2: Writing loT data acquisition scripts

31

Training standards — Unit 2

3.1.1  Training guidelines

Ability / Learning outcome:

Write Python scripts to collect
data from loT sensors using
MicroPython

Interface sensors with code to
read and display their data
Debug data acquisition errors
Extract sensor data

Training site:

Indoor room of approximately 4 x 5 m
equipped with:

Wide window

Fire extinguisher

Many Electrical switches and
sockets to accommodate several
PCs

Fixed wooden high-chair furniture
suitable for electronics lab
activities

Desks and benches where we can
place PCs, tools, and materials for
practical work

Closet and drawers for organizing
and storing electronic
components and lab materials

A soil area (or soil containers) inside
the room for testing soil moisture
sensors

Required Tools:

e PC & Monitor or Laptop with USB

port

Internet connection

Anti-Static Mat ESD Safe
Multimeter

Power Bank

5V DC Adapter micro USB
Storage boxes for components

wire cutters)

Basic tool kit (screwdrivers, pliers,

Required Materials and
Consumables:

e ESP8266 Development Board
(e.g., NodeMCU, Wemos D1 Mini)
Micro USB data cable
DHT22/DHT11 sensor module
Soil Moisture sensor module
Ambient light sensor module
18650 Li-lon rechargeable battery
+ holder *1

LEDs

Resistors

Push buttons module

switches

Breadboard

Jumper wires (female-male, male-
male)

Write Python scripts to collect data from loT sensors using MicroPython

§ Thonny - <untitled> @ 1:1
File Edit View Run Tools Help
1&d O e =

Open Thonny IDE:

<untitled>

Shell
>>> print("Hello GIZ Team")
Hello GIZ Team

3> ‘

Open Thonny IDE by double-clicking the Thonny icon on your desktop or search
for “Thonny” in your start menu to open the IDE.

Connect your ESP8266 or ESP32 to your computer using a USB cable.

Ensure Thonny detects the device (check the bottom-right corner for “MicroPython

(ESP8266)" and the correct COM port).

Check that the REPL is working by typing:

print("Hello MicroPython") and confirm the message appears without errors.
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<untitled> - data_acquisition py

print("IoT Data Acquisition

script Running”)

MicroPython (ESP32) » CP2102

Create a .py script

e Click on File > New, or press Ctrl + N. An empty script editor will open in Thonny,
ready for your loT code.
e Save the script:
o Click File > Save As.
o Choose where to save: On your computer for local editing and later upload or
directly onto the microcontroller if you run the script immediately.
o Name your file clearly, for example: data_acquisition.py
e Prepare for coding at the top of your script:
o Import necessary libraries (machine, time, sensor libraries).
o Initialize your sensor.
o Write your data acquisition loop.
e Testsaving and running:
o Write a test line in your script:
o print("loT Data Acquisition Script Running")
o Click Run (F5) to ensure your script executes, and the message appears in the
Shell/REPL.

import
import time
inport

Use import machine, import time, and sensor-specific libraries

o |dentify required libraries for loT data acquisition:
Core libraries:
o machine for GPIO and hardware control.
o time for timing and delays.
Sensor-specific libraries:
Example: dht for DHT11/DHT22 sensors.
e Open the loT Script:
o Open Thonny IDE.
o Open the data_acquisition.py script or create a new .py file for testing imports.
o Write Import Statements at the Top of the Script:
import machine
import time
import dht # or your sensor’s specific library
e Save the script.
Tip: Press Enter after typing each line so it runs correctly in Python.
The # symbol is used for comments, anything after # is ignored by the Python interpreter
and is only there to help you understand the code.

499
333
e

>33

22>

MPY: soft reboot
>>>

Test import statements

e Run the script using Run (F5). If no errors appear, the imports are successful.

If an error like ModuleNotFoundError appears:

e Check that the library is uploaded to the microcontroller in Thonny,

e Open the library file from your computer and use File > Save As... > MicroPython
device, then confirm it appears in the device’s file list.

e Confirm the correct spelling of the library name.

Developing Python Applications for loT Devices 251015 Done

Page 19 of 65



Improving the Quality and Attractiveness of Vocational Education and Training in Lebanon for vulnerable social groups (QuA-VET)

Review the 3 sensors and connection requirements

Sensor type (DHT11, soil moisture, light sensor).
GPIO pin used for the sensor signal.
Whether the pin should be set as INPUT (reading data) or OUTPUT (sending signals).

|dentify:

Use the sensor's datasheet or lab wiring diagram to confirm pin numbers and
voltage compatibility.

inport dht

sensor_pin = machine,Pin(5, machine,Pin.IN)

sensor = dht,DHT11(sensor_pin)

print{"6P10 pin and sensor initialized successfully")

shel

»m

»

Write initialization code for DHT 11 sensor

Note: When writing your full script, follow a clear structure:

Initialize the GPIO Pin of the DHT11 sensor in the code
o Use the machine.Pin class to set up the pin.
Example for an input pin: sensor_pin = machine.Pin(5, machine.Pin.IN) #
GPIO5 as input
Initialize the DHT 11 sensor using the Library
o Use the initialization function from your sensor library.
Example:
import dht #press enter
sensor = dht. DHT11(sensor_pin) # Create a sensor object linked to GPIO5
Test Initialization
o Add a simple print test to confirm no errors:
o print("GPIO pin and sensor initialized successfully")
Run the script in Thonny:
o Ifthe message displays without errors, initialization is successful.
o Iferrors appear, check wiring, pin numbers, or library imports.

Import libraries

Initialize pins and sensors

Loop to read, print, and store data
Handle errors

O O O O

Write initialization code for the soil moisture

The soil moisture sensor usually comes with:

Pinout:
AO (Analog Out) — Connects to ADC pin of ESP8266 (A0).
DO (Digital Out) — Optional, can be connected to a GPIO pin for digital threshold.

o Probe (two metal pins that go into the soil).
o Signal board (with power pins and output).

Initialize the Analog Digital Conversion Library
from machine import ADC
Map AO pin of sensor to AQ of ESP8266:
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soil_sensor = ADC(0) # ADC pin is fixed to A0 on ESP8266
e Read the moisture value
moisture_value = soil_sensor.read()
e Add a simple print test to confirm no errors:
print("Soil moisture:", moisture_value)
e Run the script in Thonny:
o Ifthe message displays without errors, initialization is successful.
o Iferrors appear, check wiring, pin numbers, or library imports.
Write initialization code for the light sensor

The light intensity sensor outputs an analog signal, so we use the ADC pin (A0) of the
ESP8266.
Initialize the ADC Pin of the Light Sensor in the code:
from machine import ADC
# Initialize ADC on pin A0
T ——— light_sensor = ADC(0) # ADC(0) is the only ADC pin on ESP8266
e Test Initialization
value = light_sensor.read() # Returns value 0-1023
print("Light sensor initialized, value:", value)
e Run the script in Thonny:
If a value between 0 and 1023 is displayed, initialization is successful.

Interface sensors with code to read and display their data

Connect the DHT 11 sensor to the ESP8266

o |dentify:
Sensor type (e.g., DHT11, soil moisture sensor, light sensor).
Pin connections and GPIO pin numbers.
Sensor voltage and communication requirements.
e  Connect the circuit consisted of the DHT11 module and the Esp8266 or ESP32
development module:
o Connect the Vice of the DHT11 module to the Ve (3.3V) of the ESP8266 dev
module using the red wire
o Connect the ground (0V) of the DHT11 module to the ground of the ESP8266
dev module using the black wire
Connect the data of the DHT11 module to the D1 (GPIO5) of the ESP8266 dev
module using the orange wire.
Write a code to read the sensor (Example the temperature and humidity sensor
DHT11 or DHT 22)

e Create an instance of your sensor linked to its GPIO pin

import dht

wy sensor = dht.DHT11(machine.Pin(5)) #or DHT22

(The DHT stands for Digital Humidity and Temperature sensor)

except oserror as e , e Read data from the sensor by using the following method from the sensor’s library:

print("Failed to read from DHT sensor:”, e)

ine. steen(s) For DHT11:

try:

sensor.measure()

temperature = sensor.temperature()

humidity = sensor.humidity()

o Display Sensor Data in the REPL by using the print() function to display the sensor’s
data clearly. Example:
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print("Temperature:", temperature, "°C")
print("Humidity:", humidity, "%")
e EmbedinaLoop toread Continuously (infinite loop)
e  Wrap the reading and displaying code inside a while True loop:
while True:
sensor.measure()
temperature = sensor.temperature()
humidity = sensor.humidity()
print("Temperature:”, temperature, "°C")
print("Humidity:", humidity, "%")
time.sleep(5)
Tip: We need to allow sensors time to stabilize between readings. That’s why we Use:
time.sleep(5) # Wait 5 seconds before the next reading to slow down the loop.
This enables continuous monitoring in the REPL.
e  Save the script and click Run (F5).
. If errors occur, guide learners to:
o Check wiring and initialization code.
o Check the exact sensor library method names.
e  Save the script and run it in Thonny

Connect the soil moisture sensor to the ESP8266

o |dentify:
o Sensor type: Soil Moisture Sensor (analog output).
o Pin connections: VCC, GND, AO (analog out).
o Sensor voltage: 3.3V supply.
o Communication: Analog signal — ESP8266 ADC pin (A0).

e Connect the circuit consisting of the soil moisture sensor module and the ESP8266
development board:

e Connect the VCC of the soil moisture module to the 3.3V (Vcc) of the ESP8266 dev
module using a red wire.

e Connect the GND of the soil moisture module to the GND of the ESP8266 dev
module using a black wire.

e Connect the AO (Analog Out) of the soil moisture module to the A0 (ADC pin) of the
ESP8266 dev module using an orange wire.

Write a code to read the soil moisture sensor

« Initialize the sensor object in Code, The soil moisture sensor provides an analog
output, so we use the ESP8266’s ADC pin (A0).
from machine import ADC
soil_sensor=ADC(0) # Create a soil sensor object linked to AQ

o Read Data from the Sensor, Use the read() method from the ADC class to collect
data.
value = soil_sensor.read() # Returns 0-1023

o Display Sensor Data in the REPL, Use the print() function to display the sensor’s
data.
print("Soil moisture value:", value)

e Embed in a Loop for Continuous Reading (infinite loop)

o Wrap the reading and displaying code inside a while True loop:

import time

from machine import ADC

# Initialize the Soil Moisture Sensor (AO — A0)
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soil_sensor = ADC(0)
print("Soil moisture sensor initialized successfully”)
while True:
# Read the raw value (0 - 1023)
value = soil_sensor.read()
# Display raw value
print("Soil moisture value:", value)
time.sleep(5) # Delay 5 seconds before the next reading
The delay gives the sensor time to stabilize and prevents spamming the REPL.
e Runand test the code
o Save the script and click Run (F5) in Thonny.
o Iferrors occur, guide learners to:
= Check wiring (VCC — 3.3V, GND — GND, AO — A0).
= Check that the correct ADC method (read()) is being used.
» Make sure only AQ is used for analog input (ESP8266 has only one
ADC).

Debug data acquisition errors

When working with microcontrollers and sensors, errors can arise from different sources. 5,
Some are hardware-related, such as loose or broken connections, using the wrong GPIO
pins, incorrect pin wiring, or an insufficient power supply to the sensor. Others stem from
the code itself, including syntax mistakes like missing colons or typos, incorrect GPIO pin 55
numbers, or missing and wrongly imported libraries. Finally, there are runtime errors that =~ =«
occur during execution. These may include issues such as ModuleNotFoundError,
OSError when attempting to read from a sensor, or simply no data being displayed in the
REPL console.

recent call last):
1>, line &, in <module>
me 'machine' isn't defined

Use print statements for debugging
e Add print statements to identify where the script fails:

print("Script started")
print("Sensor initialized")
print("Reading sensor data...")

Verify the hardware connections

e Check if the Sensor wires are connected to correct GPIO pins.
e  Check if the Power (VCC) and Ground (GND) are securely connected using the
multimeter.

e Check if the microcontroller is properly connected and detected by the computer

Verify GPIO pin configurations in code & library imports

e Ensure the GPIO pin numbers in the code match the physical connections.

o Verify the correct mode (e.g., machine.Pin.IN for input).

e Check that necessary libraries are imported without typos:

import machine

import time

import dht

e Ensure external libraries (e.g., dht.py, ssd1306.py) are uploaded to the
microcontroller if required.

import machine
import time
import dht
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Handle sensor-specific runtime errors

e  Fix OSError or read failures by:
o Adding appropriate delays using time.sleep().
o Wrapping sensor reads in try-except blocks:

sensor.measure()

temp = sensor.temperature()

print(temp)

except OSError as e:

print("Sensor read error:", e)

Document the Issue and Fix

e Keep a simple debugging log:
o Error observed
o Fix applied

Extract sensor data

MPY: soft reboot
Temp: 30.1° Humidity: 40.9%
Temp: 30.
Temp: 30.
Temp: 30.
Temp: 30.
Temp: 30.
Temp: 30.
Temp: 30.
Temp: 30.
Temp: 30.

Humidity:
Humidity:
Humidity:
Humidity: 40
Humidity: 40
Humidity: 2
Humidity: 40.8%

cococooococoor
nononnnaaaa

Store data in variables

e Use clear, descriptive variable names:
temperature_celsius = sensor.temperature()
humidity_percent = sensor.humidity()

import time
from machine import ADC

soil_sensor = ADC(9)

moisture_readings = []
print(“Collecting soil moisture data...")
while True:

value = soil_sensor.read()

moisture_readings.append(value)

print("soil moisture value:", value)
print("All readings so far:", moisture_readings)

time.sleep(5)

Collect data over time

e Demonstrate how to store data in lists for monitoring trends:

temperature_readings = []
humidity_readings = []

temperature_readings.append(temperature_celsius)
humidity_readings.append(humidity_percent)
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Import time

Pk i ampans: goc Format data for clarity

soil_sensor = ADC(@)

o (Create readable output strings:

FaisAne TS Lo ] data_string = "Temp: {}°C | Humidity: {}%".format(temperature_celsius,
print(“Collecting soil moisture data...") humidity_percent)

print(data_string)

while True:

value = soil_sensor.read()
moisture_readings.append(value)

print("soil moisture value:”, value)
print("All readings so far:", moisture_readings)

time.sleep(5)

Prepare Data for Storage or Transmission

import time
from machine import ADC

e Write data to files
ST _ with open('data_log.txt, 'a') as file:
A file. write(data_string + '\n)

while True:

value = soil_sensor.read()

cere_string = oot v e 0 rerneccatse) | [t Will @ppend each reading to data_log.txt on the ESP8266's internal filesystem. Each
new value is saved on a new line.

with open('data_log.txt', ‘a') as file:

as
file.write(data_string + "\n')

time.sleep(s)

Note: The ESP8266 has limited storage. For longer-term logging, you'd typically move
data to an SD card or send it over Wi-Fi (MQTT/HTTP)
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3.1.2 Tools and materials

With installed (Python 3.8+, Thonny IDE, and USB
Drivers: CP210x / CH340 Drivers and Administrative
privileges to install drivers/software

Tools Picture Quantity? Comment
PC & Monitor & keyboard & mouse (Windows OS 1 per station

installed)

Or Laptop with USB port

Internet connection
With WiFi network credentials

Multimeter

1 per station

1 per station

Anti-Static Mat ESD Safe

1 per station

Power Bank

1 per station

5V DC Adapter micro-usb

1 per station

Storage drawer cabinet for components

1 per station

2 The quantity expressed for workshop means that the item can be used for different modules in the same workshop, this imply that
two modules that are using the item could not be delivered at the same time. Warning! before purchasing the item it should be
verified if it already exists in the workshop to avoid unnecessary duplications. Also, the list should be reviewed and verified by an

experienced professional.
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Tools Picture Quantity? Comment
Basic tool kit (screwdrivers, pliers, wire cutters) P 1 per station
NG,
A
Materials and consumables . Quantity (per Comment
Picture .
station)

ESP8266 Development Board (e.g., NodeMCU, Wemos 1

D1 Mini)

Micro USB data cable 1 Data cable,
not just
charging

DHT22/DHT11 sensor module 1

Soil Moisture sensor module 1

Light sensor module 1

LED 5

Resistors 470 ohm, 1kohm and 10 kohm 10 each

Push button module 2
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Materials and consumables . Quantity (per Comment
Picture .
station)
ON/OFF Switch — 2
Breadboard 1

Jumper wires (female-male and male- male)

1 pack of each

18650 Li-lon rechargeable battery

18650 Li-lon rechargeable battery holder with wire
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3.2 Assessment standards - Unit 2

3.21 Formative assessment

Trainee Name:

Date:

Ability /
learning outcome

Criteria for competence unit 2 - Writing loT data acquisition scripts

Yes / No

Write Python scripts
to collect data from
loT sensors using
MicroPython

Does the candidate open the Thonny IDE correctly and connect the ESP8266/ESP32 via
usB?

Does the candidate verify that Thonny detects the device and that the REPL is functional?

Does the candidate create a new .py script and save it with a clear filename?

Does the candidate import necessary libraries (machine, time, and sensor-specific) at the
top of the script?

Does the candidate write an initial test line (print("loT Data Acquisition Script Running")) and
run the script successfully in Thonny?

Does the candidate identify and correctly import the required core and sensor-specific
libraries?

Does the candidate test the import statements and handle errors like ModuleNotFoundError
if they occur?

Does the candidate review sensor types, GPIO pins, and pin modes before coding?

Interface sensors
with code to read
and display their
data

Does the candidate write initialization code for the DHT11 sensor, including GPIO pin
setup?

Does the candidate initialize the DHT11 sensor object using the sensor library and test it?

Does the candidate write initialization code for the soil moisture sensor using ADC and test
reading values?

Does the candidate write initialization code for the light sensor using ADC and test reading
values?

Does the candidate connect the DHT11 sensor to the ESP8266 with correct VCC, GND, and
data pins?

Does the candidate create code to read the DHT11 sensor data and display temperature
and humidity in the REPL?

Does the candidate embed sensor reading and displaying in a continuous loop with
appropriate delays?

Does the candidate connect the soil moisture sensor to the ESP8266 correctly and write
code to read and display analog values continuously?

Debug data
acquisition errors

Does the candidate use print statements effectively to identify where the script may fail?

Does the candidate verify hardware connections, ensuring sensors are connected to the
correct GPIO pins and power lines?

Does the candidate verify GPIO pin configurations in code match the physical wiring and
correct library imports?

Does the candidate handle sensor-specific runtime errors, e.g., using try-except for OSError
or other read failures?

Does the candidate document observed errors and applied fixes in a debugging log?

Extract sensor data

Does the candidate store sensor readings in descriptive variables (e.g.,
temperature_celsius, humidity_percent)?

Does the candidate collect multiple readings over time and store them in lists for monitoring
trends?

Does the candidate format data for clear output using strings before printing?

Does the candidate save data to a file (data_log.txt) on ESP8266 or prepare it for
transmission?

Does the candidate ensure the saved data is appended and formatted for later use?
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3.2.2 Summative assessment
Trainee name: Date:
Assessor name: Date:
The candidate is considered competent if he demonstrates a best practice performance in all the following criteria for the
assessment related to the competence unit 2 - Writing loT data acquisition scripts
Criteria for assessment Qualifier YES | NO (%)
The candidate should be able to, in 20 minutes or less, create and save
Script setup and a MicroPython script in Thonny IDE, import the required libraries, 0O .
initialization initialize the GPIO pins with correct modes, and initialize the connected
sensor using the appropriate library commands without errors.
The candidate should be able to, in 20 minutes or less, implement a
o while loop in the MicroPython script to continuously read sensor data
D_ata acquisition and using the correct methods, display the extracted data clearly in the REPL H H
display using print() statements, and include an appropriate delay between
readings to ensure stable operation.
The candidate should be able to, in 10 minutes or less, correctly connect
Hardware connection the loT sensor to the microcontroller according to the wiring diagram,
o . . ; O O
and verification verify physical connections and power, and confirm that the
microcontroller detects the sensor setup for further data acquisition.
The candidate should be able to, in 15 minutes or less, write and execute
Code initialization, a MicroPython script that initializes the GPIO pins and sensor, reads O .
reading, and display data using the appropriate library methods, and displays live sensor data
clearly in the REPL without errors.
The candidate should be able to, in 10 minutes or less, identify errors
- occurring during sensor data acquisition, apply systematic debugging
Debug data acquisition steps including checking hardware connections, verifying GPIO
errors . . . S . . . O O
configurations, inspecting library imports, using print statements, and
applying try-except handling, and confirm that the script executes
without errors while displaying correct live sensor data in the REPL.
The candidate should be able to, in 10 minutes or less, extract sensor
Extract sensor data data by reading it using the appropriate library methods, store the data
in clearly named variables, format the data for clarity, and display it in O O
the REPL to confirm correct and stable readings suitable for analysis,
logging, or further loT processing.
Criteria (*) Evidence of non-compliance if any (**)
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Assessor signature:

Date:

Trainee signature:

Date:
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4 Competence Unit 3: Developing programs to control devices

41 Training standards — Unit 3

411 Training guidelines

Ability / Learning outcome: Required Tools: Required Materials and
Consumables:
e PC & Monitor
»  Write control programs in Python | ¢ |ntemet connection o [ESP8266 Development Board
for actuators and peripheral e Multimeter (e.g., NodeMCU, Wemos D1 Mini)
. 'd}z\gtcéejntrol logic to actuate e Power Bank e Micro USB data gable (ensyre it is
devices based on conditions * DC Adapter 12V a data cable, not just charging)
«  Use GPIOs and PWM outputs e 5V DC Adapter micro USB e DHT22/DHT11 sensor module
«  Refine control logic using *  Storage boxes for components * Waterlevel sensor module
hardware connections e Basic tool kit (screwdrivers, pliers, | ®  Soil Moisture sensor module
Training site wire cutters) e Ambient light sensor module
raining sie. e Battery 12V, 3 A or more e 18650 Li-lon rechargeable battery +
Indoor room of approximately 4 x 5m | ¢ Anti-Static Mat ESD Safe holder
equipped with: * RGBLEDs
o Wide window  LEDs
o Fire extinguisher e Resistors
e Many Electrical switches and e Buzzer
sockets for the PCs e Push buttons module
o Fixed wooden high-chair furniture e switches
suitable  for  electronics lab e Servo motor
activities e DC motor
o Desks and benches where we can e  H-bridge module
place PCs, tools, and materials for e Relays module
practical work e Pump
» Closet and drawers for organizing e Breadboard
and storing electronic e Jumper wires (female-male, male-
components and lab materials male)
A soil area (or soil containers) inside e breadboard Power Supply Module
the room for testing soil moisture 3.3Vav
Sensors
Write control programs in Python for actuators and peripheral devices
Open the development environment
e Launch Thonny IDE.
e Connect the ESP8266 development board via USB to the PC.
o Confirm the ESP8266 is connected, and the COM port is recognized.
o Open a new Python file for the control program.
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Import required libraries

Machine library is used For GPIO and PWM control. Time library is used for delays and
timing control.
o Start the code by typing:
import machine
mport Cine import time
relay e i e pinoury | ® Click on File then select save as. Save the script as control_actuator.py for clarity.
o |dentify and Initialize GPIO Pins

e Set the GPIO pins that will control actuators as outputs. Example:

led = machine.Pin(2, machine.Pin.OUT)

For a relay or motor driver:

relay = machine.Pin(5, machine.Pin.OUT)
o Emphasize using clear, descriptive variable names for each actuator.
Write basic control logic

o Start by turning the actuator ON and OFF:
led.on() # Turns LED on
time.sleep(1) # Waits 1 second

mport tima led.off() # Turns LED off
time.sleep(1)
relay - machine.pin(s, machine.pin-OT) o Test by creating a simple blinking loop:
while True:
M eton() led.on()
o espt) print("LED is ON')
led.of () time.sleep(1)
Erint(;LED(ﬁ QFF") Ied Off()
ime.sleep .
print("LED is OFF")
time.sleep(1)

Tip: To stop infinite loops during execution in Thonny, use Ctrl+ C.
Save and upload the script

e  Save the script with a clear name.
¢ Run the script from Thonny to observe the actuator response.

Test control logic to actuate devices based on conditions
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Create the script for logical testing

Open Thonny IDE and create test_control_logic.py.
Import necessary libraries:
import time
Initialize a simulated “device state™
device_state = "OFF"
Write a loop to test logic:
count=0
while True:
if count % 2 == 0:
device_state = "ON"
else:
device_state = "OFF"
print("Loop:", count, "Device State:", device_state)
count += 1
time.sleep(1)
Execute the script.
Observe the REPL output
Add comments for clarity

Syntax:

if condition:

# action

else:

# alternative action

Modify conditions for practice

Add nested conditions (e.g., multiple states).
Simulate a sensor value:
sensor_value = 25
if sensor_value > 20:
device_state = "ON"
else:
device_state = "OFF”

Tip: It is better to use descriptive and clear variable names example
temperature_celsius.

Use GPIOs and PWM outputs
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Write GPIO control code

e Open Thonny IDE and create a new script (gpio_pwm_control.py).
e Import libraries:

import machine

import time
¢ |nitialize a GPIO pin as output:

led = machine.Pin(2, machine.Pin.OUT)
o Control the pin to turn an LED ON and OFF:

led.on()

time.sleep(1)

led.off()

time.sleep(1)
o Use print() statements to indicate the action if hardware is not connected.
Write PWM control code

o Explain PWM as a way to simulate analog output by varying the duty cycle of digital
signals
o Initialize PWM on a GPIO pin:
pwm = machine.PWM(machine.Pin(2))
pwm.freq(1000) # Set frequency to 1kHz
o Change duty cycle to control intensity or speed:
for duty in range(0, 1024, 200):
pwm.duty(duty)
print("Duty cycle:", duty)
time.sleep(0.9)
¢ Run the script and observe outputs in the REPL.
e Try one more example: Dimming an LED Using PWM
import machine
import time
pwm = machine.PWM(machine.Pin(2))
pwm.freq(1000) # 1kHz frequency
while True:
for duty in range(0, 1024, 100): # Increase brightness
pwm.duty(duty)
print("Duty:", duty)
time.sleep(0.2)
for duty in range(1023, -1, -100): # Decrease brightness
pwm.duty(duty)
print("Duty:", duty)
time.sleep(0.2)

Refine control logic using hardware connections

Set up the hardware

e Connect ESP8266 to Laptop
o Use a USB Data cable (not a charge only cable) to connect the ESP8266
board to your laptop.
e Open Thonny
e Goto Tools > Options > Interpreter:
o Select MicroPython (ESP8266)
o Set the correct COM port (usually auto-detected)
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e  Connect the circuit on the Breadboard
o GPIO Output Example:
Connect GPIO5 (D1) — first terminal of the resistor (220Q)
Connect the second terminal of the resistor to the positive terminal of the
LED (long pin)
Connect the second pin of the LED (short leg) to the GND (0V)
o PWM Example:
Connect GPI014 (D5) — servo signal wire
Servo VCC — 3.3V or external 5V (depending on model)
Servo GND — GND
o Input Device Example: Push button:
One pin to GPI0O4 (D2), other to GND
(Use internal pull-up in code)
Write initial control logic

e Open Thonny to write a MicroPython script with GPIO and PWM control logic.

Example snippet:
from machine import Pin, PWM
from time import sleep
led = Pin(5, Pin.OUT)  # GPIO5
servo = PWM(Pin(14), freq=50) # GPIO14 for PWM
button = Pin(4, Pin.IN, Pin.PULL_UP)
while True:
if button.value() == 0:
led.on()
servo.duty(40) # Example position
else:
led.off()
servo.duty(75)
sleep(0.1)

e Save the file as main.py in Thonny
e  Click Run or press F5 to upload the code
e Confirm that the ESP8266 executes the logic automatically on reboot

Note that the code will auto-run again whenever the board is reset or powered on.
Refinement process

e Observe the hardware's behavior:

o Isthe LED reacting as expected?

o Is the servo reaching the right angle?

o Are transitions smooth?

Add delays to debounce buttons

Calibrate servo angles

Use print statements in Thonny REPL for live debugging
Adjust logic thresholds or duty cycle values

Modify the code and redeploy.

Recheck behavior with each change.

Use comments to document changes or logic explanations.
Have multiple versions (e.g v1, v2 ,...) to track development progress.
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41.2 Tools and materials

Tools

Picture

Quantity?

Comment

PC & Monitor & keyboard & mouse (Windows OS installed)

Or Laptop with USB port

Python 3.8+, Thonny IDE , and USB Drivers: CP210x / CH340
Drivers

Administrative privileges to install drivers/software

WiFi network credentials

1 per station

Internet connection 1 per class

Multimeter 1 per station
Power Bank 1 per station
5V DC Adapter micro-usb 1 per station
12V DC Adapter 1 per station

3 The quantity expressed for workshop means that the item can be used for different modules in the same workshop, this imply that
two modules that are using the item could not be delivered at the same time. Warning! before purchasing the item it should be
verified if it already exists in the workshop to avoid unnecessary duplications. Also, the list should be reviewed and verified by an
experienced professional. Also, the list should be reviewed and verified by an experienced professional.
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Tools

Picture

Quantity?

Comment

Storage drawer cabinet for components

1 per station

Battery 12V, 3 A or more
+clips

1 per
classroom

Anti-Static Mat ESD Safe

1 per station
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Materials and consumables . Quantity Comment
Picture .
per station

ESP8266 Development Board (e.g., NodeMCU, Wemos D1 1

Mini)

Micro USB data cable 1 (ensureitis
a data
cable, not
just
charging)

DHT22/DHT11 sensor module 1

Water level sensor module 1

Soil Moisture sensor module 1

Light sensor module 1

RGB LED - 1

.ﬁ’(
LED 5
Q\
N
Resistors 470 ohm, 1kohm and 10 kohm 10 each
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Buzzer

Push button module 2
ON/OFF Switch 2
Servo Motor 1
DC Motor 1
Relay Module 1
H-Bridge Module 1
Pump 12V 1 per
classroom
Breadboard 1

Breadboard Power Supply Module 3.3V 5V
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Jumper wires (female-male and male- male)

1 pack of
each
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4.2 Assessment standards - Unit 3

Formative assessment
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Trainee Name:

Date:

Ability /
learning outcome

Criteria for competence unit 3 - Developing programs to control
devices

Yes / No

Write control
programs in Python
for actuators and
peripheral devices

Does the candidate open Thonny IDE and connect the ESP8266 board correctly via USB?

Does the candidate confirm the ESP8266 is detected and the correct COM port is
recognized?

Does the candidate create a new Python file for the control program and save it with a clear
name (e.g., control_actuator.py)?

Does the candidate import the required libraries (machine and time) at the top of the script?

Does the candidate identify and initialize GPIO pins for actuators using correct syntax and
descriptive variable names?

Does the candidate write basic control logic to turn an actuator ON and OFF with correct
use of time.sleep()?

Does the candidate create and test a simple blinking loop to verify actuator response?

Does the candidate save and upload the script to observe the actuator functioning?

Test control logic to
actuate devices
based on conditions

Does the candidate create a Python script for testing control logic (test_control_logic.py)?

Does the candidate import necessary libraries and initialize simulated device states?

Does the candidate write a loop to test logical conditions and display output in the REPL?

Does the candidate use if-else statements correctly to switch device states based on
conditions?

Does the candidate modify and test nested conditions or simulate sensor values for
practice?

Does the candidate use descriptive variable names to improve code readability and
maintainability?

Use GPIOs and
PWM outputs

Does the candidate initialize GPIO pins as outputs and control devices (e.g., LEDs) using
on() and off()?

Does the candidate implement print statements to indicate actions when hardware is not
connected?

Does the candidate initialize PWM on GPIO pins and set frequency correctly?

Does the candidate vary the duty cycle to control intensity or speed of actuators?

Does the candidate write and test a loop to gradually increase and decrease PWM output
(e.g., LED dimming)?

Does the candidate observe PWM outputs in the REPL and confirm correct behavior?

Refine control logic
using hardware
connections

Does the candidate connect the ESP8266 board to the laptop using a proper USB data
cable and select the correct MicroPython interpreter in Thonny?

Does the candidate assemble hardware circuits for GPIO outputs, PWM devices (e.g.,
servo), and input devices (e.g., push button) correctly?

Does the candidate write control logic in Python that reacts to input devices (e.g., button
presses) and controls actuators accordingly?

Does the candidate test and observe hardware behavior to ensure actuators respond as
expected?

Does the candidate refine the control logic by adding delays, calibrating actuators, adjusting
thresholds, and redeploying the code?

Does the candidate use print statements for live debugging and document changes using
comments?

Does the candidate maintain multiple script versions to track development progress and
improvements?
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4.2.2 Summative assessment
Trainee name: Date:
Assessor name: Date:

The candidate is considered competent if he demonstrates a best practice performance in all the following criteria for the

assessment related to the competence unit 3 - Developing programs to control devices

Criteria for assessment Qualifier YES | NO (%)
Write control programs in The pandidate shoulld bg able to, in 15 mi.nutes orless, crgate a.nd s_ave
MicroPvthon f a .MlgroPython s_crlpt in Thonny IDE, |mport the regwred Ilbrarles,
icroPython for - O O
actuators and peripheral initialize GPIO pins for aptuators or. peripheral dewces,l vynte and
devices execute control logic to switch the devices ON and OFF within a loop,
and verify correct operation through REPL output without errors.
The candidate should be able to, in 15 minutes or less, create and save
a MicroPython script in Thonny IDE, write a while loop with a condition
Test conditional control that changes a simulated device state variable, display the device state O =
Logic in the REPL using print() statements, execute the script, and verify that
the device state changes correctly according to the condition logic
without errors.
Configure GPIO pinsto | The candidate should be able to, in 10 minutes or less, to initialize at
control digital devices least one GPIO pin as output and demonstrate digital control by
using MicroPython and | toggling the state (HIGH/LOW) and to troubleshoot common GPIO O O
troubleshoot common errors and implement necessary corrections.
GPIO errors
Generate and modify The candidate should be gble to, inl 10 minutes or less, to set up a
PWM sianals t irol PWM output on a GPIO pin and adjust duty cycle or frequency to N .
gnals to contro
analog behavior create observablg hardware response and to tlroubleshoot common
PWM errors and implement necessary corrections.
Refine control logic using The candidate should be able to, in 30 minutes or less, connect a sensor
hardware connections and an actuator to the ESP8266, upload a control program, run the code O O

in both simulation and hardware, verify the behavior, analyze the results,
and refine the control logic to ensure proper system response.

Criteria (*)

Evidence of non-compliance if any (**)

Assessor signature:

Date:
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Trainee signature:

Date:
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5 Competence Unit 4: Establishing network connectivity using Python for cloud integration

5.1

Training standards — Unit 4

5.1.1  Training guidelines
Ability / Learning outcome: Required Tools: Required Materials and
. , , Consumables:
o  Configure network settings for e PC & Monitor
loT devices e Internet connection o ESP8266 Development Board
o Write Python scripts to connect e Multimeter (e.g., NodeMCU, Wemos D1 Mini)
devices to cloud platforms e Power Bank e Micro USB data cable (ensure itis
o Transmit sensor data securely to e DC Adapter 12V a data cable, not just charging)
the cloud e 5V DC Adapter micro USB e DHT22/DHT11 sensor module
e  Troubleshoot basic network ° Storage boxes for components o \Water level sensor module
connectivity and data e Basic tool kit (screwdrivers, pliers, | ®  Soil Moisture sensor module
transmission issues wire cutters) e Ambient light sensor module
Training site: e Anti-Static Mat ESD Safe e 18650 Li-lon rechargeable battery
Indoor room of approximately 4 x 5 m + holder
equipped with: e RGBLEDs
e  Wide window e LEDs
e Fire extinguisher e Resistors
e Many Electrical switches and o Buzzer
sockets for the PCs e  Push buttons module
o Fixed wooden high-chair furniture e switches
suitable  for  electronics  lab e Ultrasonic distance sensor module
activities e Breadboard
»  Desks and benches where we can e  Jumper wires (female-male , male-
place P(IDS, toi?ls, and materials for male)
practical wor
e Closet and drawers for organizing * g'rg\zjd;)\c;ard Power Supply Module
and storing electronic
components and lab materials
A soil area (or soil containers) inside
the room for testing soil moisture
Sensors

Configure network settings for loT devices

Configure Wi-Fi Settings Using MicroPython

e Make sure the device is within range of the Wi-Fi router

e Ensure your network allows 2.4 GHz Wi-Fi (ESP8266/ESP32 do not support 5 GHz)
e Write a Basic Wi-Fi Connection Script

import network

import time

def connect_to_wifi(ssid, password):
wlan = network. WLAN(network.STA_IF)
wlan.active(True)
if not wlan.isconnected():
print('Connecting to network...")
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wlan.connect(ssid, password)
timeout = 10
while not wlan.isconnected() and timeout > 0:
time.sleep(1)
timeout -= 1
if wlan.isconnected():
print('Connected:’, wlan.ifconfig())
else:
print(*Failed to connect)

connect_to_wifi("Your_SSID', "Your_PASSWORD)

o Save the file as boot.py or wifi_connect.py.
e Upload to ESP using Thonny’s file manager.
¢ Restart the board and monitor output on the Thonny shell.

Write Python scripts to connect devices to cloud platforms

- Setup the Cloud Account (ThingSpeak)

Enter: https://thingspeak.mathworks.com in your browser
Click the “Get Started For Free” button to create a ThingSpeak account.
Open Channels -> select My Channels -> Create a new channel.
Type a name for your channel and add a description.
o If you want to publish multiple readings (like humidity and pressure), you
can enable many fields.
o Click the Save Channel button to create and save your channel.

CJThingSpeak™ channeis -

My Channels

Name Created

CJThingSpeak™ ctanne - Apps=  Support-

New Channel

Name as0s m

- © To send values from the ESP8266 or ESP32 to ThingSpeak, you need the Write API
: Key. Open the “API Keys” tab and copy the Write API Key and Channel ID to a safe
place because you'll need it in @ moment.

Important note: Do not share your API key publicly as it gives access to your data.

Write APl Key

Key HEOBXOH. Td 597" |

Write MicroPython Script: HTTP Post to ThingSpeak

e Type the following code
import network

import urequests

import time

def connect_wifi(ssid, password):
wlan = network. WLAN(network.STA_IF)
wlan.active(True)
if not wlan.isconnected():
wlan.connect(ssid, password)
while not wlan.isconnected|):
time.sleep(1)
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print("Connected:", wlan.ifconfig())

def send_to_thingspeak(api_key, value):
url = "https://api.thingspeak.com/update ?api_key={}&field1={}". format(api_key, value)
response = urequests.get(url)
print("Server response:", response.text)
response.close()

# Example usage

connect_wifi('YourSSID', "YourPassword')

while True:
sensor_value = 42 # Replace with actual sensor reading
send_to_thingspeak("YOUR_API_KEY', sensor_value)
time.sleep(15)

Customizing Chart

Field 1 Chart Options

ustomized. go 1o your Private Vi

lew tab and click on the edit icon

Customize the Chart

e (o to your Private View tab

e Click on the edit icon.
o Give a title to your chart,
o Customize the background color, x and y axis, and much more
o When you're done, press the “Save” button.

Transmit sensor data securely to the cloud

Wire the DHT11 or DHT22 to ESP8266 or ESP32

e Insert the DHT11 sensor onto the breadboard.
e  Connect the VCC pin of the sensor to the 3.3V pin on the ESP.Connect GND to
GND.

e Connect the data pin of the sensor to GPIO2 on the ESP.

Verify sensor readings using a simple Python script on Thonny

e Type the following script:

import dht
import machine
import time
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sensor = dht. DHT11(machine.Pin(2))

while True:
sensor.measure()
temp = sensor.temperature()
hum = sensor.humidity()
print('Temp:’, temp, 'C Humidity:', hum, '%')
time.sleep(2)

Secure Wi-Fi Connection Setup

e Use network module in MicroPython.
import network

sta_if = network. WLAN(network.STA_IF)
sta_if.active(True)
sta_if.connect('YOUR_SSID', 'YOUR_PASSWORD))

while not sta_if.isconnected():
pass

print(‘Connected.’, sta_if.ifconfig())

Write a basic script for connecting to Wi-Fi, reading the DHT sensor, and sending
data to ThingSpeak

e Type the following script:
import network

import urequests

import utime

import dht

from machine import Pin

# Wi-Fi credentials
ssid = "'YOUR_SSID'
password = 'YOUR_PASSWORD'

# Connect to Wi-Fi

sta = network. WLAN(network.STA_IF)
sta.active(True)

sta.connect(ssid, password)

while not sta.isconnected):
print("Connecting to Wi-Fi...")
utime.sleep(1)

print("Connected, IP:", sta.ifconfig()[0])

# Sensor setup
sensor = dht.DHT11(Pin(2)) # GPIOZ2 is D4

# ThingSpeak API
api_key = 'YOUR_API_KEY'
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url = ‘https.//api.thingspeak.com/update'

# Loop
while True:
sensor.measure()
temp = sensor.temperature()
hum = sensor.humidlity()
print(f Temp: {temp}°C | Humidity: {hum}%')

# Send data
full_url = f{url}?api_key={api_key}&field1={temp}&field2={hum}"
try:
response = urequests.get(full_url)
print("Sent to ThingSpeak:", response.text)
response.close()
except:
print(*Failed to send data.")

utime.sleep(15)
e Save the code as main.py.

o Upload it to the ESP using Thonny.
o Run it and monitor the REPL output for logs and errors.

@ Measurements - empertr

Verify on cloud

e Login to ThingSpeak.com.
e  Open your channel dashboard.
o View real-time temperature and humidity graphs updating every 15 seconds.

Troubleshoot basic network con

nectivity and data transmission issues

Read device status

o Access serial monitor output
e Review connection status messages:
o “Connecting to Wi-Fi...”
o “Connection successful” + IP address
o “Connection failed” or authentication error

o Demonstrate how to check IP and network info: Use sta_if.ifconfig() in MicroPython

to retrieve and interpret IP configuration
o Test this script that attempts Wi-Fi connection:
import network
import time
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# Replace with your Wi-Fi credentials
SSID = "Your_SSID"
PASSWORD = "Your_PASSWORD"

def connect_to_wifi():
wlan = network. WLAN(network.STA_IF)
wlan.active(True)

if not wlan.isconnected|):
print("Connecting to Wi-Fi...")
wlan.connect(SSID, PASSWORD)

# Wait until connected or timeout after 10 seconds
timeout = 10
while not wlan.isconnected() and timeout > 0:
print("Waiting for connection...")
time.sleep(1)
timeout -= 1

if wlan.isconnected():
print("Connected successfully!")
print("Network config:", wian.ifconfig())
else:
print(*Failed to connect.”)

connect_to_wifi()

Handle errors in Python scripts

o Implement error logging by adding print statements or log errors for diagnosis
e Sample code demonstration: Show a simple script with error handling for HTTP
requests
import urequests
try:
response =
urequests.get('https://api.thingspeak.com/update ?api_key=YOUR_API_KEY&field1=25)
if response.status_code == 200:
print(*Data sent successfully”)
else:
print(*Failed with status code:", response.status_code)
response.close()
except Exception as e:
print("Error occurred:”, e)

Debug data transmission failures

o Check HTTP responses: When sending data, review the returned status code. For
example:
200 - Data sent successfully
403 - Access forbidden; check API key or permissions
404 - Resource not found; verify URL or endpoint
500 - Server error; try again later or check server logs
o Verify data on cloud platforms by logging in to the platform dashboard and confirm
whether the data has been received, stored, or rejected.
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o Manage API rate limits: If multiple requests are sent in a short time, pause between
requests to avoid exceeding the allowed limit.

o Test network connectivity by pinging the Wi-Fi network or send simple test requests
to confirm internet access before sending data.
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5.1.2 Tools and materials

Tools

Picture

Quantity*

Comment

PC & Monitor & keyboard & mouse (Windows OS installed)

Or Laptop with USB port

Python 3.8+, Thonny IDE , and USB Drivers: CP210x / CH340
Drivers

Administrative privileges to install drivers/software

WiFi network credentials

1 per station

Internet connection 1 per station
Multimeter 1 per station
Power Bank 1 per station
5V DC Adapter micro-usb 1 per station
12V DC Adapter 1 per station

4 The quantity expressed for workshop means that the item can be used for different modules in the same workshop, this imply that
two modules that are using the item could not be delivered at the same time. Warning! before purchasing the item it should be
verified if it already exists in the workshop to avoid unnecessary duplications. Also, the list should be reviewed and verified by an
experienced professional. Also, the list should be reviewed and verified by an experienced professional.
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Tools Picture Quantity* Comment

Storage drawer cabinet for components 1 per station

Basic tool kit (screwdrivers, pliers, wire cutters) 1 per station

Anti-Static Mat ESD Safe 1 per station

Materials and consumables Picture Quantity Comment

ESP8266 Development Board (e.g., NodeMCU, Wemos D1 1

Mini)

Micro USB data cable 1 (ensureitis
adata
cable, not
just
charging)

DHT22/DHT11 sensor module

Water level sensor module

Soil Moisture sensor module
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Materials and consumables Picture Quantity Comment
Light sensor module 1
RGB LED 1
LED 5
Resistors 470 ohm, 1kohm and 10 kohm 10 each
Buzzer 1
Push button module 2
ON/OFF Switch 2
Breadboard 1
Breadboard Power Supply Module 3.3V 5V 1
Jumper wires (female-male and male- male) 1 pack of
% each
18650 Li-lon rechargeable battery 2
18650 Li-lon rechargeable battery holder with wire 2
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5.21 Formative assessment
Trainee Name: Date:
Ability / Criteria for competence unit 4 - Establishing network connectivity Yes / No
learning outcome | using Python for cloud integration
Does the candidate ensure the loT device is within Wi-Fi range and that the network
supports 2.4 GHz?
Does the candidate write a basic MicroPython script to connect the device to Wi-Fi?
Does the candidate correctly use network.WLAN (network.STA_IF) to activate the Wi-Fi
- interface?
gecmggtsjr%ﬁa;\%vork Does the candidate implement a connection loop that waits for successful Wi-Fi connection
devi g with a timeout?
evices Does the candidate display connection status and IP configuration in the REPL?
Does the candidate save the Wi-Fi script correctly (e.g., boot.py or wifi_connect.py) and
upload it to the device?
Does the candidate restart the board and monitor the Thonny shell output for connection
confirmation?
Does the candidate create a cloud account (e.g., ThingSpeak) and configure a channel with
fields for sensor data?
Does the candidate retrieve and securely store the Write API Key and Channel ID?
Does the candidate write a MicroPython script to connect to the cloud via HTTP requests
; : (urequests)?
Yggfniigzneiggs Does the candidate import necessary libraries (network, urequests, time) and establish Wi-
o cloud plat Fi connectivity in the script?
0 cloud platiorms Does the candidate correctly format the HTTP request URL to send data to the cloud
channel?
Does the candidate implement a loop to periodically send sensor or test data to the cloud?
Does the candidate customize the cloud platform’s chart display and verify the data fields
are correctly mapped?
Does the candidate wire the DHT11/DHT22 sensor correctly to the ESP8266/ESP32 (VCC,
GND, data pin to correct GPIO)?
Does the candidate verify sensor readings using a Python script in Thonny?
Does the candidate set up a secure Wi-Fi connection using the network module in
; MicroPython?
Z;?gzrggu?:rsg the Does the candidate write a script that reads sensor data and sends it to the cloud using the
loud y appropriate API key?
clou Does the candidate implement errors in handling failed HTTP requests when transmitting
data?
Does the candidate monitor the REPL output for successful transmission logs and sensor
readings?
Does the candidate verify that data is correctly displayed on the cloud platform in real-time?
Does the candidate read and interpret serial monitor output to identify connection status
messages?
Troubleshoot basic Does the candidate use sta_if.ifconfig() to check IP and network configuration?
network connectivit Does the candidate implement and test Wi-Fi connection scripts with proper handling of
and data y connection failures and timeouts?
fransmission issues Does the candidate log errors or use print statements to diagnose HTTP request failures?
Does the candidate check HTTP response codes (e.g., 200, 403, 404, 500) and interpret
them correctly?
Does the candidate verify data reception on the cloud platform and confirm whether it is
stored, rejected, or delayed?
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Does the candidate manage API rate limits and test network connectivity to ensure reliable
data transmission?
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5.2.2 Summative assessment
Trainee name: Date:
Assessor name: Date:

The candidate is considered competent if he demonstrates a best practice performance in all the following criteria for the
assessment related to the competence unit 4 - Establishing network connectivity using Python for cloud integration

Criteria for assessment Qualifier YES | NO (%)
The candidate should be able to, in 20 minutes or less, configure the

Configure network network settings of an loT device by updating the SSID and password

settings for loT devices in the script or configuration file, deploying the changes to the device, O O
and verifying that the device successfully connects to the specified Wi-
Fi network with a valid IP address.
The candidate should be able to, in 60 minutes or less, successfully

loT cloud integration connect an |oT device to a cloud platform by writing a Python script that O O
configures Wi-Fi setting

Hardware and Network The candidate should be ablel to, in 30 minutes or Ies§, correctly coqngct

Conf . the sensor hardware to the microcontroller and establish a stable Wi-Fi l ]

onfiguration :

connection

Secure Data The candidate should be able to, in 30 minutes or less, write, deploy,

Transmission and Cloud | and run a Python script that reads sensor data and securely transmits it U [

Integration to the cloud platform, handling errors and verifying data receipt.

T . The candidate should be able to, in 30 minutes or less, identify and

roubleshoot basic . . )

network connectivity and resolve 'baS|c network'connectllv!ty anq dgta transmission issues py

debugging Python scripts, verifying Wi-Fi and cloud platform settings, O O

data transmission issues

and ensuring successful sensor data upload and confirmation on the
cloud dashboard.

Criteria (*)

Evidence of non-compliance if any (**)

Assessor signature:

Date:

Trainee signature:

Date:
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6 Competence Unit 5: Performing end-of-work activities

6.1 Training standards — Unit 5

6.1.1  Training guidelines

Ability / Learning outcome: Required Tools: Required Materials and
, _ Consumables:

e Conduct cleanup and backup e PC & Monitor or Laptop with USB
o Document source code port e ESP8266 Development Board
» Store hardware tools e Windows OS installed (e.g., NodeMCU, Wemos D1 Mini)
» Report according to task records | « = Python 3.8+ e Micro USB data cable (ensure it is
Training site: e IDE: (Thonny/VS Code/uPyCraft) a data cable, not just charging)
Indoor room of approximate|y 4 x 5m e USB Drivers: CP210x / CH340 | ¢ DHT22/DHT11 sensor module
equipped with: Drivers e Soil Moisture sensor module
e Wide window e WiFi network credentials e Ambient light sensor module
o Fire extinguisher e Internet connection e 18650 Li-lon rechargeable battery +
e Many Electrical switches and | e Administrative privileges to install holder

sockets for the PCs drivers/software e LEDs
e Fixed wooden high-chair furniture | e  Anti-Static Mat ESD Safe e Resistors

suitable for electronics lab | e Storage drawer cabinet for | e Breadboard

activities components e Jumper wires (female-male , male-
 Desksand bencheswherewecan | o  Basic tool kit (screwdrivers, pliers, male)

place PCs, tools, and materials for wire cutters) e breadboard Power Supply Module

practical work 3.3V 5V
o Closet and drawers for organizing

and storing electronic

components and lab materials

Conduct cleanup and backup

Cleanup on the development PC

Open the folder where scripts are saved.
Check for .pyc, .log, .temp, .old, or .zip files.

Remove (delete) or archive unnecessary files.

Create a local backup folder

o Create a folder named loT_Backup_<date>.
o Copy essential .py files and configurations into it.
e Add a README.txt to describe the content and version.

Log the cleanup and backup on your memory stick

o Fill out a cleanup/backup report with:
o Date &time

Files removed

Files backed up

Backup location

Comments on any issues

O O O O

Document source code

Developing Python Applications for loT Devices 251015 Done

Page 58 of 65



Improving the Quality and Attractiveness of Vocational Education and Training in Lebanon for vulnerable social groups (QuA-VET)

Demonstrate Inline and Block Comments and Python comment syntax:

e Use Python’s triple-quote docstrings:
def connect_wifi():

o o prederined WL-FL. etk uslng 15268 e Connects to a predefined Wi-Fi network using ESP8266 module.
True connection succeeds, False iise. Returns
bool: True if connection succeeds, False otherwise.

pass

Create and save a Basic README File

e Create and save README:

o Project name
Description and purpose
Setup instructions
How to run
Author and contact
Organize documentation files

readme.txt

O
O
O
O

o Store all project guides, manuals, and README files there.

o Use comments and docstrings in Python scripts to explain code functionality.

¢ Include version numbers or dates in filenames for scripts and documents to track
updates.

Store hardware tools

Cleanup before storage

Wipe down tools with appropriate cleaning material

Remove any residues (e.g., solder, dust, oils)

Check for visible damage

Report or tag defective tools for repair or disposal

Sort tools into predefined categories

Use dividers or foam inserts for protection

Ensure storage of jumper wires, sensors and components in anti-static bags or
compartments

Return tools to their designated labeled storage bins

Ensure labels are clear and match inventory system (if available)
Place ESD-sensitive devices in anti-static containers

Disconnect all batteries or power sources from active components

Report according to task records

Document task activities

« Maintain reporting for traceability, accountability, maintenance, and project
continuity.

o Record different types of task information: maintenance logs, configuration reports,
error logs, and test results.

e Include all key components in a task report: date/time, team members involved, task
description/objectives, methods/procedures, tools/software/equipment used, issues
and resolutions, outcomes/results, and follow-up actions.

Developing Python Applications for 0T Devices 251015 Done Page 59 of 65




Improving the Quality and Attractiveness of Vocational Education and Training in Lebanon for vulnerable social groups (QuA-VET)

o Review and analyze task records (real or simulated) to extract key data, ensuring
clarity, completeness, and technical accuracy.

o Complete reporting templates (manual and digital) with concise, objective, and
technically correct information using proper terminology.
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6.1.2 Tools and materials

Tools

Picture

Quantity’

Comment

PC & Monitor & keyboard & mouse (Windows OS installed)

Or Laptop with USB port

Python 3.8+, Thonny IDE , and USB Drivers: CP210x / CH340
Drivers

Administrative privileges to install drivers/software

WiFi network credentials

Internet connection

1 per station

1 per station

loT device catalogs and specifications sheets
MicroPython syntax reference sheet

1 per station

Storage drawer cabinet for components

1 per station

Basic tool kit (screwdrivers, pliers, wire cutters)

1 per station

Anti-Static Mat ESD Safe

1 per station

5 The quantity expressed for workshop means that the item can be used for different modules in the same workshop, this imply that
two modules that are using the item could not be delivered at the same time. Warning! before purchasing the item it should be
verified if it already exists in the workshop to avoid unnecessary duplications. Also, the list should be reviewed and verified by an
experienced professional. Also, the list should be reviewed and verified by an experienced professional.
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Tools Picture Quantity’ Comment

ESP8266 Development Board (e.g., NodeMCU, Wemos D1 1

Mini)

Micro USB data cable 1 (ensure itis
adata
cable, not
just
charging)

DHT22/DHT11 sensor module 1

Soil Moisture sensor module 1

Light sensor module 1

LED 5

Resistors 470 ohm, 1kohm and 10 kohm 10 each

Breadboard 1

Breadboard Power Supply Module 3.3V 5V 1

Jumper wires (female-male and male- male) 1 pack of

% each
18650 Li-lon rechargeable battery - 2
18650 Li-lon rechargeable battery holder with wire 2
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Tools

Picture

Quantity®

Comment
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6.2 Assessment standards - Unit 5

6.2.1 Formative assessment

Trainee Name:

Date:

Ability /
learning outcome

Criteria for competence unit 5 - Performing end-of-work activities

Yes / No

Conduct cleanup
and backup

Does the trainee identify unnecessary files (.pyc, .log, .temp, .old, .zip) in the development
PC folder?

Does the trainee delete or archive unnecessary files correctly?

Does the trainee create a local backup folder with the correct naming convention
(loT_Backup_<date>)?

Does the trainee copy all essential .py files and configuration files into the backup folder?

Does the trainee create a README.{xt describing the content and version of the backup?

Does the trainee complete a cleanup/backup report including date/time, files removed, files
backed up, backup location, and comments on issues?

Document source
code

Does the trainee use inline and block comments in Python scripts appropriately?

Does the trainee implement Python docstrings for functions to describe purpose, inputs,
outputs, and behavior?

Does the trainee create and save a basic README file including project name,
description/purpose, setup instructions, execution instructions, and author contact?

Does the trainee organize all documentation files in the designated folder with proper
filenames, version numbers, and dates?

Store hardware tools

Does the trainee clean tools before storage, removing residues and checking for visible
damage?

Does the trainee report or tag defective tools for repair or disposal?

Does the trainee sort tools into predefined categories and use protective dividers or foam
inserts?

Does the trainee store jumper wires, sensors, and components in anti-static bags or
compartments?

Does the trainee return tools to labeled storage bins with clear labels matching the inventory
system?

Does the trainee ensure ESD-sensitive devices are stored in anti-static containers?

Does the trainee disconnect all batteries or power sources from active components before
storage?

Report according to
task records

Does the trainee maintain reporting for traceability, accountability, maintenance, and project
continuity?

Does the trainee record different types of task information, including maintenance logs,
configuration reports, error logs, and test results?

Does the trainee include all key components in a task report: date/time, team members, task
objectives, methods/procedures, tools/software/equipment, issues/resolutions,
outcomes/results, and follow-up actions?

Does the trainee review and analyze task records to extract key data with clarity,
completeness, and technical accuracy?

Does the trainee complete reporting templates (manual and digital) with concise, objective,
and technically correct information using proper terminology?
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6.2.2 Summative assessment

Trainee name: Date:

Assessor name: Date:

The candidate is considered competent if he demonstrates a best practice performance in all the following criteria for the

assessment related to the competence unit 5 - Performing end-of-work activities

Criteria for assessment Qualifier YES | NO (%)
The candidate should be able to, in 30 minutes or less, identify and

Conduct cleanup and remove unnecessary files, organize essential project components, and

backup create a properly named backup folder that includes all critical scripts, O O
configuration files, and documentation. The backup should be
successfully saved in a secure location and verified for completeness.
The candidate should be able to apply inline comments, write consistent
function-level docstrings, and create a concise README that explains

Document source code - . X
the script’'s purpose, usage, dependencies, and expected inputs/outputs, l Ol
ensuring the code is understandable and maintainable by another
Python developer within 30 minutes.
The candidate should be able to clean, organize, and store all hardware
tools within 15 minutes, ensuring damaged or faulty tools are identified

Store hardware tools and reported, each tool is placed in its designated location, ESD- O Ol
sensitive items are protected, the storage area is tidy and complete, and
any anomalies are documented.

Report according to task The candidate should be able to, in 30 minutes or less, compile and

P g submit a technical report based on a completed task, using the

records : . e o Ol ]
appropriate format and ensuring that all critical information is extracted
accurately from the task record.

Criteria (*) Evidence of non-compliance if any (**)

Assessor signature: Date:

Trainee signature: Date:
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